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Agenda

BlueTile

(STEVAL-BCNO002V1)

WiFi Network: STMicro
Password: STMTTT19

* Training Material Check/Installation Help

 ARM® Keil MDK Installation

* Introduction to Bluetooth® Low Energy

* BlueTile Development Kit

- ARM® Keil MDK License Installation

* Lab 1: Getting Started with BlueTile “Serial Terminal Test”
« Lab 2: Connecting to the ST BLE Sensor app

* Lab 3: LED characteristic

* Lab 4: Accelerometer embedded events detection
« Lab 5: 9-axis Acc+Gyro+Mag Sensor Data Fusion
- Lab 6: Cloud data logging on IBM Watson

"[ - Lab 7: Bonus — Voice over BLE
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On St.com
http://www.st.com/bluetile

Contact Us English v~
life.augmented

I products @ Applicatons § Tools & Software About ST Support & Community & Login

Evaluation Tools > Solution Evaluation Tools > Sensor Solution Eval Boards » STEVAL-BCNOO2V1B >

STEVAL-BCNOO2V1B =% Print ‘ Save to MyST Share via Email

This product is in stock in our
e-store

Download databrief =7 Sample and buy

BlueTile - Bluetooth LE enabled sensor node development kit

Overview Tools & Software Resources Quality & Reliability

The STEVAL-BCN002V1B Bluetooth LE enabled sensor node development kit features the STEVAL-
BCNO0O02V1 multi-sensor board based on BlueNRG-2 SoC Bluetooth Low Energy application processor.
This sensor board has accelerometer, gyroscope, magnetometer, pressure, humidity, Time-of-Flight and

r microphone sensors, and is powered by a common CR2032 coin battery.

The sensor board communicates with a Bluetooth LE
life.augmented
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BlueTile SDK
http://www.st.com/bluetile

Contact Us English v
,I Products ~ Search..
lite.augmented

i Products @ Applicatons § Tools & Software Support & Community & Login

Evaluation Tools > Solution Evaluation Tools » Sensor Solution Eval Boards > STEVAL-BCNO0O2V1B >

STEVAL-BCNQOO2V1B = print M Save to MyST Share via Email

S Oftwa re This product is in stock in our
BlueTile - Bluetooth LE enabled sensor node development kit e-store
Development %7 Sample and buy
K i t

Overview Tools & Software Resources Quality & Reliability
Quick links
Evaluation Tool Software Wireless Connectivity Software

Embedded Software

EVALUATION TOOL SOFTWARE >

‘ " WIRELESS CONNECTIVITY SOFTWARE >
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BlueTile SDK' e

https://www.st.com/content/st com/en/products/embedded-software/evaluation-
tool-software/stsw-bluetile-dk.html

STSW-BLUETILE-DK e &= Print M Saveto MyST Share via Email
Software development kit for the BlueTile, including sensor data streaming over BLE, HID peripheral, Beacon, etc.
Get Software Download databrief
Overview Tools & Software Resources

The STSW-BLUETILE-DK is based on STSW-BLUENRG1-DK evaluation SW package.

] The STSW-BLUENRG1-DK package supports the
Reset Manager . BlueNRG-1 and BlueNRG-2 Bluetooth Low-Energy
system-on-chip. This package includes a Wizard PC
ety HaL | ciyptoiip | Bluevoice | motionFx application to automatically generate the configuration
[ visaLax | HTs221 [LPsazh [Lsmenso Lisamo | header file needed for the BLE radio initialization. This
=B package also includes BlueNRG-1 and BlueNRG-2
peripheral drivers and related examples, the BLE
firmware stack together with the HAL (Hardware
Abstraction Layer) and CryptoLib (Cryptographic
Library).
The STSW-BLUETILE-DK supports the BlueTile

mlatfarms Thie narlkana aviande QTQIN_RI T IRPMBR 24N

App Utilities

BlueNRG-2 Peripherals

v | wrosomos | coweoso | _mean

Lys
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https://www.st.com/content/st_com/en/products/embedded-software/evaluation-tool-software/stsw-bluetile-dk.html

On St.com
http://www.st.com/bluetile

Contact Us English
life.augmented

2 Products P Applications § Tools & Software About ST Support & Community & Login

Evaluation Tools > Solution Evaluation Tools > Sensor Solution Eval Boards » STEVAL-BCNOO2V1B >

¥asd Share via Email

q STEVAL-BCNOO2V1B & pint M saveto MyST
S c h e m at I C This product is in stock in our

e-store

G e rbe rs S| Download databrief
BOM

Overview Tools & Software Resources Quality & Reliability
Quick links
Product Specifications Presentations Board Manufacturing Specifications
Bill of Materials Schematics Brochures

r License Agreement
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Companion ST BLE Sensor App mm
&

ON YOUR PHONE

- Look for “ST BLE Sensor” on the App Store or Google Play

|

# Download on the ]

S App Store

GET ITON
' Google Play




Where to Get I{ =

Sample & Buy

Part Number Marketing Budgetary Quantity Core Product ECCN Country Order from Distributors Order from ST

- Status Price (U55§) (US) of Origin

STEVAL- 50.0 1 BlueNRG-2, BALF-NRG- SA992C ITALY W Check Availability 27 Buy direct
BCNOOD2V1B 0203, LSMBDSO, X y

LISZMDL, VL33L1X,
MP34DTOSTR-A,
LPS522HH, HTS221

Lys
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Where to Get It

» Contact Mouser (USA) (200) 346-6273 | & Feedback Change Location English s Uk
M. MQH;SEEQ Products Manufacturers Technical Resources Services & Toeols Help Order History Log In Register !
All v | n [Jin Stock [1RoHS
All Products > Embedded Solutions > Engineering Tools » Sensor Development Tools » © see an Eror?

Multiple Function Sensor Development Tools » STMicroelectronics STEVAL-BCNO0ZV1B

Order in the next 58:18 to ship today. Learn More

STEVAL-BCNO002V1B In Stock: 49
c—’ 77 Mouser #: 511-STEVAL-BCN0OD2V1B Stock: 49 Can Ship Immediately
ougrreehead
Mfr. #: STEVAL-BCNOO2V1B On Order: 30
View Delivery Dates
Mfr.: STMicroelectronics
Factory Lead-Time: 11 Weeks
Customer #:
Minimum: 1 Multiples: 1
Enter Quantity:
Description: Multiple Function Sensor Development Buy
Tools BlueNRG-Tile - Bluetooth LE enabled
sensor node development kit Pricing (USD)
Enlarge Lifecycle: @ New Product: New from this o )
Qty. Unit Price Ext. Price
manufacturer.
Images are for reference only " q
See Product Specifications Datasheet: h STEVAL-BCNO02V1B Datasheet $50.00 $50.00
.c Share More Information: Learn more about STMicroelectronics
STEVAL-BCNOO2V1B
NEWEST PRODUCTS
Shipping Alert: [EAR] This product may require additional STMICROELECTRONICS

documentation to export from the United
‘ ’ I States.

life.augmented
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https://my.st.com/ols

Lys
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‘,’ Products v Search...

Products
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® Applications § Tools & Software i About ST

Welcome back!

Enter your e-mail address and password to login your myST user

E-mail address

Password

Remember me on this computer.

Online Suppor

New user?

myST brings you a set of personalized features:

> Participate to ST Events

o Stay informed with ST eMewsletters
> Get help with ST Online Support

> Discuss on the ST Community

© Benefit from our Online Design Tools
> Download Software

> Order free samples

> Manage your weekly product updates
© Buy ST Products & Tools

Create Account

Contact Us

Support & Community

English v

Support



https://my.st.com/ols

Online Support

m STMicroelectronics Service Port]l New Request RAF RIVA G

lizo.augmented

No Cases found. Click on 'New Request' to create one.

ﬁ STMicroelectronics Service Portal New Request A RAF RIVA C* Logout
Lito.cugnanted
Case Details

I I I S e rt tI l e I a rt N u I I | Please specify email in the "D i " or 'C boxes fo add people in copy of this request. This will be added by the Support Agent.

STEVAL-BCNO02V

‘ ,’ Type something
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Introduction to
Bluetooth Low Energy
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Bluetooth® Evolution

« 20 Years in the market!
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Bluetooth Classic
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Bluetooth Low Energy (LE)

Designed for Success

Lower power than Bluetooth “Classic” (or Bluetooth 3.0)
« Lower duty cycle

« Faster connection

* Lower peak power (relaxed RF parameters)

Compatible with all major platforms (iOS, Android, Windows, Linux)

Multiple network topologies:

» Point to point: single master connects to single slave (and each slave can connect to 2
master)

« Star: Multiple slaves connected to a single master
* Mesh: introduced in the 2017

State of the Art encryption, security including privacy/authentication
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]1{ BLE System
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Protocol Stack

Application
BLE Application Profiles

» Generic Acces Profile
» How a device can discover and connect with one another

* Generic Attribute Profile
 How services, characteristics can be discovered and then used

* Attribute Protocol
» Protocol for discovering, reading, and writing attributes on a peer

- Security Manager
 Handles the secure communication

- L2CAP
» Protocol multiplexer. Segmentation and reassembly of packets

« HCI
* Interface between Host and Controller

* Link Layer
« Handles packets, channels, advertising, scanning & connections

* Physical Layer
* Transmits/receives bits

Host Controller Interface

Link layer

PHY layer



Protocol Stack: PHY

- ABLE Radio is a 2.4 GHz ISM Band Transceiver
- 40 RF Channels, 2 MHz Channel Spacing. Two types of channels:

« Advertising channels (3 - orange) for Advertising Packets. Used for Discoverability and
for Broadcasting/Observing

- Data Channels (37 - blue) for Data Packets. Used to send application data in Connection

* GFSK Modulation
« BT=0.5
 Modulation Index = 0.5

heranroorna BT N oo E 23 TNRIRERSR2350233333 * “pulse shaping” Gaussian
> filter “smooths” transitions
N N N N N N N N N N N N N N N N N N N
G Hittttttttbtb bbb bbbt e bbbttt bttt E bbb Speciel Wi
w

life.augmented Source : Bluetooth® SIG



Protocol Stack - GAP

Application
_ ‘ - Who controls the radio network?
 GAP (Generic Access Profile)
—»
O -  Broadcaster
= L * Observer
..% * Peripheral
7p)
W = [
m 0
£
= y
O
‘1 O [ PHY layer

=
o]
Q
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I’'m looking
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Peripheral is in Advertising mode.
Sends Advertising packets.

Central is Scanning.
Look for known peripherals by listening

to advertising packets.
My name is John

My capabilities are X, Y, Z,
Advertising packets consists of multiple

,)) information units known as AD types.
‘_ E.g.: Local Name, TX Output Power,
> /4 Manufacturer Specific info, etc...

life.augmented

As the John peripheral is found,
it initiates a BLE connection.



Protocol Stack - GATT

Application

BLE Application Profiles

\
Host

‘ - Who controls the data flow?

 GATT (Generic Attribute Profile)

* Defines 2 roles

e Server
 Client

Host Controller Interface

Link layer

Controller

PHY layer

.51 BLE System
|

(@]
3
0]
=
Q



GATT

| G]

Client talks to

Server contains
Requests the server.
the data.
, Sends requests,
Receives requests, )
. wait for response.
executes, responds. )
e Can confirm
Can indicate value Responses o
indications

Protocol PDU Type | Sent by | Description

Request Client Client requests something from server (it always causes a response)
Response Server  Server sends response to a request from a client

Command Client Client commands something to server (no response)

Notification Server  Server notifies client of new value (no confirmation)

Indication Server  Server indicates to client new value (it always causes a confirmation)

"I Confirmation Client Confirmation to an indication

life.augmented



Attributes

- Data are organized and exposed as attributes

Server
Each Data element Data
_ in the Serveris ~.__
- Each attribute has: called Attribute Data
- A handle: it identifies the attribute on the server Data

- Atype (defined by Universal Unique ID - UUID): what the
value means
» 16-bit UUID: pre-defined by Bluetooth SIG
« 128-bit UUID: Vendor Specific identifiers

- Avalue (0 to 512 octets)

. Example Handle |Type _____|Vale

0x0009  «Device Name» “Temperature Sensor’
0x0022  «Battery State» 0x04
Ox0098 «Temberaturey Source [BY3ROH® SIG




GATT Profile

Profile

Service _ _
- A GATT Profile defines how attributes are
Characteristic : L
organized and how the application can
Characteristic access them.

* Attributes are organized in Services and
Characteristics

Service

Characteristic
Characteristic

a typical example:
1 service: “ARG” (Angular Rate and Gravity)

2 characteristics: “Gyro”, “Acc”
‘Y Values: [0,-1,+2], [-10,+15,+950]



N

ST BLE Devices %
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ST BLE Roadmap

Dual Core BLE STM32WBxx

BLE 5.0 Application processor
- Dual core Cortex-M4 / MO+
BlueN RG -Tlle Flash: 256K up to 1MB
RAM: 128K up to 256K
UQFN48, VQFN64, WLCSP100

BlueNRG-LP
BLES5.0 Application processor
Cortex-M0+ 64MHz, 256KB Flash,

up to 36 GPIOs
BlueNRG-2 QFN, WLCSP

BLE5.0 Application processor n developmen
Cortex-M0 32MHz, 256KB QFN32,
QFN48. WLCSP34

BlueNRG-1
BLE4.2 Application processor

Cortex-M0 32MHz, 160KB QFN32, \
WLCSP34

BlueNRG-MS
BLE4.1 Network processor BlueNRG STM‘?"QB‘-‘\
QFN32, WLCSP34

(/2]
L
12
=
<
LL
TH

PERFORMANCE

Lys
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BlueNRG-2 SoC at a Glance

Optimized BLE
Radio stack

The lowest power Processing power on Flexible memory
consumption demand architecture

Maximum security

3 o

>3 years lifetime on Low-power 256 KB eFLASH 70 kB FLASH ECC-256
CR20320) architecture, Cortex- 24 KB ULL SRAM 8 kB RAM AES-128
0.9 yA sleep retention) retention Secure KEY
Seamless connection Robust and

@ g

with SENSORS Reliable BLE Link Small form factor

Blugtooth 5.0 Privacy 1.2 and secure  Faster and more
certified connection 4.2 reliable data transfer

&,

Sensors

life.augmented
& (*) Based on the average current consumption in connection mode (7.059 yA, connection interval 1000 ms)



Bluetooth LE Programmable Processor

PROGRAMMABLE
Bluetooth LE ARM MCU
ULS.O ; Cortex MO with eFLASH
radio 32 MHz to host application code _
\_ AN g

Advanced High-Performance Bus (AHB)

N
PDM Decimation 12C RTC
PROGRAMMABLE | RLLEERE filter (timers) PROGRAMMABLE
PERIPHERALS Digital I/O
ADC 10 bit DC/DC
S EIE
J

GIAR SIKEIL Eatollic

SYSTEMS Tools by ARM

life.augmented STEVAL-IDB008V2 STEVAL-BCNO002V1B



BlueTile Development Kit

Lys
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STEVAL BCNOO2V1 mm
Y S
S e

SWD Connector

32KHz XTAL to enable ultra- Balun
low-power BLE sleep mode BALF-NRG
L2 bead to enable low- BLE SoC

power BLE active mode

BlueNRG-232

User button ‘ ) @ RGBLED

Microphone
MP34DTO05-A

Pressure Sensor
LPS22HH

Accelerometer + Gyro
LSM6DSO

|12C for expansion

Bottom view

Magnetometer
LIS2MDL

Humidity + Temperature
HTS221

Lys

life.augmented VL53L1 X




STEVAL-BCNO02V1 Block Diagram

Test points

RFTEST TEST ADC SDA SCL VDD G;\JD antenna

o

Matching RETEST
Network™ —° S

BALF-NRG-02D3
Integrated balun

UART_RX line User

accelerometer + gyroscope IRQ Button

ADC
LiS2mMDL BlueNRG-2

TEE TR IRQ Bluetooth 5.0 Network and

LPS22HH 15C Application processor MP34DT05-A
barometer ‘m microphone

400 1.6 MHz

HTS221 kHz 32 MHz
Relative Humidity & Temp. connector
XY V4l The 32kHz crystal enables lowest power BLE sleep mode.
NEoSEt E The inductor enables lowest power BLE active mode.

RGB LED

r time-of-flight proximity

life.augmented




STEVAL-BCNO02V1D

20-pin JTAG connector STEVAL-BCN002V1 Socket Micro-USB connector (bottom)

STLinkV3 socket

STM32L151 (bottom)

life.augmented



BlueTile SDK Overview

https://www.st.com/content/st com/en/products/embedded-
software/evaluation-tool-software/stsw-bluetile-dk.html

1. PC Applications

| Applicati
a 8 _ppceor a 2. Documentation
., Docs
° . Firmware 3. Pre-built FW images
e %10 4. Low level drivers and BLE stack library
" rver
. Project o 5. Virtual COM port drivers
G o Unlity 6. Reference examples in source code
7. Utility section: IAR BlueNRG-2 Flasher

Lys
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https://www.st.com/content/st_com/en/products/embedded-software/evaluation-tool-software/stsw-bluetile-dk.html

Documents
- Open the Docs folder

L VILITIRE_onnection_uldelnnes

.. Radio_Driver

. Application . SPL_protocol_specification _

* Device Datasheet
) Docs o 5TM32_APIs_Events_html
. Firmware o 5TM32_5PI protocol_example_html « BLE stack documentation
. Library . 5TM32_UART _protocol_example_html . Release notes
. PCDriver . U5B-to-5ERIAL_FW _upgrade_procedure APls and events
\. Project |@ index.htrnl « Programming manual
| Lility | license.bxt

* Device (and kits)

) documentation
¢ DOUble CI|Ck on Index.html « PCB design guidelines

Bring up guide
» Getting started

Lys
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Hands on Overview
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Labs Overview

Lab 1: Getting started with STEVAL-BCNO002V1 “Serial Terminal Test”
Lab 2: Connecting to the ST BLE Sensor app

Lab 3: LED characteristic

Lab 4: Accelerometer embedded events detection

Lab 5: 9-axis Acc+Gyro+Mag Sensor Data Fusion

Lab 6: Cloud data logging on IBM Watson

Lab 7: Voice over BLE



Lab 1

Getting Started with STEVAL-BCN0O02V1B
“Serial Terminal Test”



“Serial Terminal Test”

| @
=

* Plug the BlueTile to the PC using the USB cable

- Install and open Tera Term and configure serial terminal




Connect Your STEVAL-BCNOO2V1B

to the PC Using USB

4 5.1 Favorites
Bl Desktop
J4. Downloads

—ai N |

s
1= Recent Places

4 o Libraries
Connect the USB cable > ) Documents
> JI' Music
The BlueTile comes already > [ Pictures
> i Videos

connected to the daughterboard

4 1M Computer
> & 0SDisk (C)
> e BCNOO2VL (D:)

GTAZOONIE-TVAILS
\ :

———— :\\ |

L e oo
On the PC file system a
"’ BCNO002V1 drive will appear

life.augmented




Windows/7: Allow the Driver Installation

1. Click on Install driver software
anyway

il Update Driver Software - STMicroelectronics ﬂ‘

o [ Update Driver Software - STMicroelectronics

2. Installation starts

Installing driver software...
[ @ Windows Security | # Update Driver Software - STMicroelectronics |
(3,-" Windows can't verify the publisher of this driver software O !ﬂl Update Driver Software - STMicroelectronics
Installing driver software...
=» Don't install this driver software
You should chedk your manufacturer's website for updated driver software for your [ ]
device,
=» Install this driver software anyway
Only install driver software obtained from your manufacturer's website or disc.,
Unsigned software from other sources may harm your computer or steal information.
j See details

Lys
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Virtual COM Port Driver

If you have issue with the STMicroelectronics Virtual COM

Port device driver installation here the instructions for
installing the Virtual COM port driver:

Win7 Win10




Tera Term Configuration 1/4

—

Host: |myhost.example.com
History :

Service: O Telnet FOR R
® 55H SSH version: |SSH?

Other 2 z
Protocol: |UNSPEGC

1. Select the STMicroelectronics Virtual COM Port

« NOTE: on Win10 PC the serial port is labeled just as “COMxx”
Lys 5 click OK

life.augmented



Tera Term Configuration 2/4

1. In Setup -> Serial port...
Set the following:

Baud rate : 115200

Data : 8 bit _
Parity : none parity:
StOp . 1 blt Stop:
Flow control : none Flow control:

Transmit delay

0 msecichar 0 mseciline

2. Click OK
Kys

life.augmented




Tera Term Configuration 3/4

e Tern e < S

Terminal size 0 rI'~-Ine'n.»'~.|r—linne N
. OK
1. In Setup -> Terminal... set W x4 Recelve: [AUTO  + j
i 1 . | Term size = win size Transmit: + - GCancel
New-line Receive : o |

g J
Auto window resize

Help |
AU TO Terminal ID: |"|.|"T1II]II] v [l Local echo

Answerback: ] Auto switch (VT<->TEK]
= Coding (receive] Coding {transmit)
2. Click OK
UTF8 | UTF8  ~|
locale: american CodePage: 63001

Lys
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Tera Term Configuration 4/4
1. Click Setup->Save setup...

2 " C I iCk S ave TeraTi Tl'efrﬁa_j'erm: e @
File Edi l'\,_../'”\.,/l | . » Computer » Windows (C:) » Program Files (xB6) » teraterm » - | +y | | Search teraterm 0 |
° Organize Mew folder = - (7]
v Favorites it Mame . Date modified Type Size
Bl Desktop . cygterm+-iGE6 5/4/2018 6:57 PM File folder
4. Downloads | . cygterm+-x85_64 3/4/2018 6:57 PM File folder
:“_.1 Recent Places 3 . lang 5/4/2018 6:57 PM File folder
‘E_? Windows (C) ./ plugin 5/4/2018 6:57 PM File folder
a Local Disk (D) R . theme 5/4/2018 6:57 PM File folder
4k | TERATERM.IMI 11/7/2018 10:52 AM  Configuration sett... 23 KB
1 Libraries

1M Computer

- P
File name: TERATERM.IMI -
Save as type: | setup files (*.ini) v]

", «  Hide Folders Help ] ’ Save d Cancel ]

life.augmented
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5|

If you see the output a

on the daughterboard

v COMI1BT - Tera Term VT

File Edit S5Setup Contrel Window Help

## STEUAL-BCHAA2U1 #

Scan for sensops:

— Accelerometer and Guroscope: QK

— Pressure and Temperature: 0K
Humidity and Temperature: 0K
Magnetometer: OK
Proximity Sensor: 0K

Sensor in low—power: OK

Battery voltage is 32VEAmU: 0K

OTA update iz NOT supported

Device 'BCH-HAH2' discoverable with MAC: ff:-29:hS5:cb:ca:c?

DoVe, IS now properly configured




Lab 2
Connect to the ST BLE Sensor App

life.augmented



Customize YOUR STEVAL-BCNOO2V1

SIKEIL &7, |
2 Ce gl + STEVAL-BCN002V1 DK
"\ |
. . ® ]
uVision®5 .
e —— Sensor Demo ref FW
KEIL is a trademark and pVision is a registered trademark of ARM Ltd All rights res d.
ﬂﬂ This product is protected by US and international laws.
weeco Verizon LTE 1:03 @ v @ % 83% mm)
. A3 1.,4',: .
: y

\\S BCN-034 ]
BlueNRG 1A:A1:E3:3F:E7:ES

life.augmented C I ie nt


https://www.google.com/url?sa=i&rct=j&q=&esrc=s&source=images&cd=&cad=rja&uact=8&ved=0ahUKEwj-i63pwYjZAhWi7IMKHcPOA3MQjRwIBw&url=https://mcuoneclipse.com/2014/11/09/using-keil-%CE%BCvision-5-with-processor-expert/&psig=AOvVaw3gXqrKdlLPIPqo9hoPSnAp&ust=1517704989834449

1.

BLE SensorDemo Application

In the BlueTile SDK browse the following path: STEVAL-
BCNO0O2V1 DK 1.1.0\Project\BLE_Examples

. BLE_Beacon

. BLE_Chat

. BELE_HID_Penpheral

. BLE_OTA_ResetManager

| er The BLE_SensorDemo
| | BLE SensorDemo | ‘ embedded application is the
_:. _Throughput pp

main reference

— — —

.. BLE_Throughput_EXT
. DTM




Integrated Development Environment
Arm Keil MDK

* MDK: Microcontroller Development Kit

« Complete software development environment from Arm for a wide range of
Arm Cortex-M based microcontroller devices.

 MDK includes the pyVision IDE, debugger, and Arm C/C++ compiler

* A FREE license is available for ST BlueNRG-2
 Go HERE to get the free license!

Lys
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BLE SensorDemo Application

- | O X

SDE_EVAL_Button.c
SDE_EVAL I2C.c
SDK_EVAL Led.c
HTS221.c
LIS2MDL.c
LP522HB.c
LPS22HH.c
LSMEDSL.c

BlueMRGL _it.c

gatt_db.c

SENSOT.C

SensorDemo_main.c
HWAdvanceFeatures.c

[ MotionFX
] MotionFX100_CMOP_Keil_ot.lib
== BlueNRG1_BlueVoice_Library
| bluevoiceADPCM_BNRGL_100_Keil lib

=] Project Books | {} Fundions | [l Templates
| b




Project o

e _ Application Structure

| BlueMRGL_Periph_Driver
-5 Platforms_Layers
] SDK_EVAL Com.c
1 SDK_EVAL_Config.c
] SDK_EVAL_Button.c
S SorEvALBC e = HW peripherals drivers and platform layer files
L] HTS221.c
L] usamDL.c
] LPS22HH.c
L] LSM6BDSO.c
[ Startup —
=55 User

) hw_confige Application source code
1 BlueNRGI it.c - Main

0 gattdb.c - ATTRIBUTE Database

i_hl SENEOr.C

{j SensorDemo_main.c - Application

ij HWAdvanceFeatures.c
g ;jck —}— Hardware Abstraction Layer and sleep management
{j libbluenrgl _stack.a
%J_'fl stack_user_cfg.c BLE Stack library — provided in binary format
| libcrypto.a
03 oTa
[ vLs3L1x
=-E5 MotionFx

m ] MotionFX100_CMOP_Keil_ot.lib } Sensor Data Fusion Iibrary

=5 BlueM RG1_BlueVoice_Library

Jife..augmented B bluevoiceADPCM_ENHGl_lUU_KeiI.Iil} Voice over BLE Ilbrary



A Look at the Main Application

int main(void) {

Systemlnit(); | Remap the vector table and configure all the interrupts priority

|

SdkEvalldentification(); ] Identifies STEVAL or custom PCB

I

Platforminit(); | HW peripherals initialization

BIueNRG_Stack_InitiaIization(&BIueNRG_Stack_Init_params);] BLE stack initialization

Sensor_Devicelnit(); | Sensors initialization

Set_DeviceConnectable(); | Set device in advertising

l while(1){ l Start of while loop

BTLE_StackTick();| Advances the stack FSM
User_AppTick();] Advances the application FSM. THIS IS DEVELOPERS USER SPACE!

m } Il end while(1)
}

i

life.augmented



Lo e

ok BLE Flow on the LAB
“W%

Central

7

— Advertise
Step 2: Scan | Advertise i P 1 .
Master is in discovery mode Advertise  £|: Slave is in Peripheral mode and
looking for a specific slave to connectto L-: ' sends ADV_IND PDU

Connection request

step 3: Connection request -

Connection created

Step 4. Ser\"ces & Chars Service & Characteristics

d iscovery discovery

Master (Client) starts the BLE Service
and Characteristics discovery procedure Notification
to understand the Server ATT DB

Step 5: Data flow

Slave (Server) starts sending
periodically (100 ms) to the master,
: notifications packets of sensors
Notification values (acc&gyro and pressure)

S—

I1 0OOmsecs

Lys
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Advertising and Scanning

Central ((( )))

. GO
el Gy &,

Bl

Advertise

Advertise Step 1: AdvertiSing
Slave is in Peripheral mode and

sends ADV_IND PDU

Step 2: Scan

Master is in discovery mode looking
for a specific slave to connect to

Advertise

|

Connection request

1

step 3: Connection request

Connection created

Master:
needs an app for

discovering the slave ‘
device in advertising

Off-the-shelf app: e.qg. Custom app: e.g.

o

E]

m LightBlue® Explorer

life.augmented https://itunes.apple.com/us/app/lightblue-explorer/id5574281107?mt=8



https://itunes.apple.com/us/app/lightblue-explorer/id557428110?mt=8

LightBlue scan results

ooooo Verizon LTE 10:31 @ 7 9 } 87% )

Sort LightBlue | Explorer

Filter

|,,,| BCN-034
-51 NO services

. Unnamead
-76 NO services

. Gear S3(385D) LE

-89 NO services

. BCN-002

-78 NO services

. GoogleHome3429

-86 | service

BlueMST

-91 No services

Unnamed
-95 NO services

Unnamed
-89 NO services

. MetaWear

86 1 service

Info ] PunchThrough

Log

Lys
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Scan Results

ST BLE Sensor scan results

< Back

Devices

X

ooooo Verizon LTE 10:30 @ v 9 % 87% mm)

BCN-034
1A:AT:E3:3F:E7:E5

|

BCN-002
D3:D0:38:ED:C2:E4

]

Why some devices are not present
in the ST BLE Sensor app?

How devices will pop up in
the ST BLE Sensor scan list?



ST BlueMS Protocol

* In order to be connected to the ST BLE Sensor app, a BLE peripheral
SHALL comply with a specific advertising packet format

- ST BlueMS protocol specifies a 26-byte packet format composed of
Advertisement Types — ADTypes - compliant with BT SIG definitions

Pre Acc Addr ... AdvA AD Flags BlueMS Adv Packet

Type | Frotocol Del‘sce F:na;:;e Device MAC Len | Type | Local Name | Len  Type Pwr
| 4 [ 1 7 | 1 1 |
| | |
Manufacturer Specific Complete Local Name  TX Out Power
ADType ADType ADType
Len =13 Len=8 Len =2

"I Type = OxFF Type = 0x09 Type = 0x0A



BlueST SDK for Android and 10S

GitHUb This repository  Search Explore Features Enterprise Pricing

Bndr id STMicroelectronics-CentralLabs / BlueSTSDK_Android © Watch

httpS :”qithub_comlstmicroelectronics_ce ntrallabs/bluestsdk android Bluetooth low energy Sensors Technology Software Development Kit (Android version)

3

D 2 commits 7 2 branches > 0 releases % 1 contributor

BAN  Branch master~ | BlueSTSDK_Android / + i=

4% GiovanniVisentini Update README Latest commit 573ce4 10 days ago

8 BlueSTExample Initial commit 14 days ago

8 BlueSTSDK Initial commit 14 days ago

u B gitignore Initial commit 14 days ago

Source code for iOS and "=
El README md Update README 10 days ago

u
A n d ro I d B build gradle Initial commit 14 days ago
E] settings gradle Initial commit 14 days ago

available online and maintained on GitHub repos STMicroelectronics-CentralLabs / BlueSTSDK_iOS © Watch | 3

| | O S Bluetooth low energy Sensors Technology Software Development Kit (iOSversion)
I D 2 commits ¥ 2 branches > 0 releases &% 1 contributor

https://github.com/stmicroelectronics-centrallabs/bluestsdk ios

(NM| | Branch: master~ BlueSTSDK_iOS / + =

. GiovanniVisentini fix parse error with multiple feature in the same characteristics == Latest commit cee8d1 2 days ago

‘ ” Il BlueSTSDK fix parse emor with multiple feature in the same characteristics 2 days ago
8 BlueSTSDKExample fix parse emor with multiple feature in the same characteristics 2 days ago

life.augmented
9 Bl LICENSE Initial commit 9 days ago


https://github.com/stmicroelectronics-centrallabs/bluestsdk_ios
https://github.com/stmicroelectronics-centrallabs/bluestsdk_android

ST BLE Sensor Scan Results

Type '?,':’rzgﬁ' DeI\I/)ice F:nf:;e Device MAC Len | Type | Local Name
®e000 Verizon LTE 10: ® 7 9 } 87% mm)
{ Back Pevices . Each ST Platform is recognized by means of a
N e ] Device ID
O oo ] (for STEVAL-BCNO002V1 it is equal to 0x05)

Users can distinguish their node from \\
the Local Name \-\
BlueNRG




Lys
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~ Customize Your BlueTile

=3 Project: BLE_SensorDemo
—-4s5 Release
| ElueMRG1_Penph_Driver
1 Platforms_Layers
1 Startup
=45 User
BlueMRG1 _it.c
gatt db.c

SENEOr.C ]

H EE B

Sensorfemo_main.c
HWAdvanceFeatures.c

B B

hw_cenfig.c

1 Hal

1 Stack

d OTA

[ VL53L1X

1 MotionFX

> BlueMRG1_BlueVoice_Library



Customize Your BlueTile mm

Modify the local name in the advertisement payload

1. In the file Sensor.c go to line 52

2. “BCN-002" is the default local name value
3. You can modify it as you prefer with a 7-characters string

22 #define DEFAULT NAME ALLMEMS ['3'r":'.r'H'.r'—'.r":",'C",'E']




Build the New Code
1. Click on the Build button (top left corner) 2 C\BueNRO T ORSTRVACEENDORVAD

File Edit View Project Flash Debug Peri

or hit F7 on your keyboard 3 @y B9 |
2. Inthe Build Output window (bottom) wait for = &k & | ¥ reease
the build to be completed. o |

- BLE_SensorDemo.bin created E‘“ﬁh
) " 3% Releace
"0 Error(s), 0 Warning(s)” message appear

Build target files no

Build Qutput I

g L5311 wait.c. . .

compiling v15311 register funcs.c...

compiling v15311 platform.c...

linking...

Program S5ize: Code=121808 RO-data=1428 RW-data=1136 ZI-data=21252
FromELF: creating hex file...

After Build - User command #1: fromelf.exe —-bin ..%..%..%..%..\..\Hand — —
LA OALONL \HandsOnABLE SensorDemo PrjOutput)\BLE SensorDemo.axf"” 0 Errori(s), 0 Warning(s).
Build Time Elapsed: 00:00:12

—-—output ..%\..%..%..%\..h..\HandsOn\BLE SensorDemo PrjCutput\BLE SensorDemo.bin

Lys
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Programming Embedded Flash
1. UART Bootloader

« ROM bootloader. HW activation through dedicate pin (DIO7) configured for Boot
* PC interface named “BlueNRG-1_2 Flasher Utility” available in the SW package

2. SWD interface + ST-LINK

* Interface with the STEVAL-BCNO02V1 through the 20-pin JTAG connector
« Same PC interface BlueNRG-1_2 Flasher

STk nk’ - } rtuig
e ) |

m- Remove CN2 Jumpers
2 and plug daughterboard
on top

STM32
"I Nucleo

life.augmented




Flash Memory Layout 1/2

SDK Projects

0x1007E800

OTA h|g her app BLE_SensorDemo_HigherApp_ OTA
(1 24kB) BLE_Chat_Server_HigherApp_OTA

0x1005F800

OTA lower app BLE_SensorDemo_LowerApp_OTA

( 124kB ) BLE_Chat_Server_LowerApp_OTA

0x10040800
Reset manager (2kB) BLE_OTA_ResetManager

BlueNRG-2 Flash

0x10040000

Lys
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0x1007FO000

0x10051800

0x10040000

Flash Memory Layout 2/2

SDK Projects

Application BLE_SensorDemo_Use_OTA_ServiceManager

with no OTA service BLE_Chat_Server_Use_OTA_ServiceManager
(182kB)

BLE_Beacon_Use_ OTA_ServiceManager

OTA Service
Manager BLE_OTA_ServiceManager

(70kB)
BlueNRG-2 Flash



UART Bootloader: Use BlueNRG-2 Fiasher

Utility

* On st.com at this link:

https://www.st.com/content/st com/en/products/embedded-software/wireless-connectivity-software/stsw-bnrgflasher.html

[ STSW-BNRGFLASHER ] ACTIVE = print Ml Saveto MyST Share via Email

BlueNRG-1, BlueNRG-2 Flasher utility

Get Software Download databrief

Overview Resources

The STSW-BNRGFLASHER is a standalone PC application which allows the BlueNRG-1, BlueNRG-2
devices Flash to be read, mass erased, written and programmed.

Lys
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https://www.st.com/content/st_com/en/products/embedded-software/wireless-connectivity-software/stsw-bnrgflasher.html

Open the Flasher Utility mem

1. Go to
C:\Program Files (x86)\STMicroelectronics\BlueNRG-1_2 Flasher Utility 3.0.0\Application

- e r
557 BlueNRG-1_2 Flasher - Utility v20.0 oo 0.

1. Double click on BlueNRG-1 Flasher GUl.exe [===

life.augmented




For HD Screens...If You've Problem with the Resolution_

- Right Click on the .exe file and select Properties

- In the Compatibility tab select either Disable display scaling...
or Override high DPI scaling... —> Application

Lys
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7 BlueNRG-1_2_Flasher_GUl.exe Properties | [ ReNEG- 12 Fiachar (Lt Properiies X
;
e PR General | Compativity | Securty Details  Previous Versions | General Compatibity | Securty Detalls Previous Versions
&7 BlueMRG-1_ —— : : . ! .
ISETEE P F s program s working coneclyon tis versenof Widows. ry e e compatbly rocesroner.
[ b2.pyd ) Run as administrator try running the trocblashonter
0 Miclrosoft.‘u" Troubleshoot compatibility I Run compatibility troubleshooter I I Run compatibiity troubleshooter ]
2 _7i How do | choose compatibility settings manually ?
%] msvem80.dl -Zip How do | choose compatibilty settings manusly?
(&) mevepg0.di CRC SHA i Compatibilty mode
|2 Psverg0.dil Edit with Notepad++ ) [] Run this program in compatibility mode for:
' ] Run this program in compatibility mode for:

|| PyQu.OtCo Scan for Viruses... Windows 8
|| PyQi4.QtGu WinhMerge Windows 8
%] python27.dl Unpin from Taskbar Settings
@' pywintypesd Pin to Start Menu Settings T T Y
] (tComd.dl Restore previous versions ] Reduced color mode aht 3
%] QtGuid.dll i ; (256) color
m QtOpEHGL4. Send to 1 il ||u-muu.l||
2] QtSvgd.dil Cut : [770vemde high DPI scaiing behavior.
2] QtXmi4.dll Copy [~] Disable display scaling on high DP| settings ~iacaling perfomed by: ...
| select.pyd . -
N Create shortcut Run this program as an administrator
| unicodedata Hesis DHL“H“ .

Farsrie program as an administrator

3 3:50 PM o -
Properties z ] — e .
_ @ Change settings for allusers | & Change settings for alusers

OK | Cancel | Apow

Ok || Cancel || ooy




BlueNRG Flasher Utility mem

File Tools Help
e e [ Select Image file ] Mo Image file loaded.
Flash from Address: |0x 10040000 |[ Fash |[ swp
user | s U A R I Flash from Address: | 0x 10040000 || Fash || stop
Actions List of COM Ports:
UART |
Automatic Mode {only ST DK — SWD
verify Actions List of COM Ports:
Mass erase d ) L
F i COM29 (5T DI
Update Device Memory Automatic Mode {Dﬂl}' 5T DK:} %Cm#
Verify COM23
Device
Flash Programming SW D Mass erase
|
| | o% Update Device Memary
Device Memory Image File \_ )
Start Address 0x10040000 Size 0x3000 Read || wite |
0 1 2 3 4 5 ]
Select Image file | Mo Image file loaded.
< ] 3
Flash from Address: |0 10040000 || Fash || stop
Log
UART SWD
\
( Actions ) MAC Address
Automatic Mode MAC Address: Start: 0x000000000000 - End: 0x000000000000
verify
MAC Flash Location 0x 10067338 |
Readuout Protection
Load Log... J [ Savelog... J ( Eemglon ] Mass erase [ ] save MAC AddressLog  File Name |
N.Board: 0/0 | | 0% Update Device Memory | Set Mac Address... |
\, J




Flash the BlueNRG-2 1/6 w=m

1. Select the COM port labeled (ST DK)

UART SWD

Actions

—

';.l'

[ — |

Automatic Mode {only ST DK)

Verify

List of COM Ports:

';i'

COMEL (5T DE)




Flash the BlueNRG-2 2/6

1. Device Memory will populate with data

Device BlueMRG-2 (max flash address: 0x1007f)

Reading Memory COM91

I 0

Device Memory COM31 | Image File |

Start Address 0x10040000 Size (0x3000 | Read || write |

6 1,2 |3 4 |5 6 |7 8 9 10 11|32 13|14 15 ASCT i
010040000 00 60 00 20 D9 07 04 10 35 06 04 10 3D 06 04 10 ~ LU 5 =

010040010 AA 55 55 AA 00 0D 0O 0O 0O 00 00 00 00 00 00 00 GuULE

010040020 0o 00 00 00 00 00 00 OO0 00 00 00 OO0 45 086 04 10 E
010040030 00 00 00 00 00 00 00 00 4F 06 04 10 58 08 04 10 oy
Log

12:10:30.832: Dewvice COMS31 -» Read Board Started
1€:10:31.701: Dewice COM91 -> Bead Board End

Lys
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Flash the BlueNRG-2 3/6

1. Select Mlass Erase

UART | swD | UART m
Actions List of COM Ports: Actions List of COM Ports:
Automatic Mode (only 5T DK) COM3L1 (5T DK] Automatic Mode (only ST DK) COMIL1 (ST DK)
Verify Verify
Mass erase Mass erase
Update Device Memory Update Device Memory

Lys
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Flash the BlueNRG-2 4/6

1. Click on the Select Image file button

&7 BlueNRG-1_2 Flasher - Utility v2.0.0

File Tools Help

[ Select Image file ]

Mo Image file loaded.

2. And browse the following path

7

STEVAL-BCMNO02VLI DE1.1.0 » Project » BLE_Examples » EBLE SensorDemo » MDE-ARM » BlueNRG-2 » LowerApp_OTA » Objects




Flash the BlueNRG-2 5/6

1. Select the binary file (e.g. BLE _SensorDemo LowerApp_ OTA.bin)
and click Open

2. Insert the correct start address (e.g. 0x10040800 for Lower App)
3. Click on the Flash button

&7 BlueNRG-1_2 Flasher - Utility v3.0.0 =B ¥ |

OoIsE Melp

| select Image file | C:fUsers/raffaele riva/Desktop/TestBlugTile_DK 1, 120190325 STEVAL-BCMNOD2V1 DK 1.1.0
29 1.1.0/Project/BLE_Examples/BLE_SensorDemo /MDK-ARM/BlueMR.G-2/Lower App_OTA /Objedts/BLE_SensorDemo_LowerApp_OTA.bin
010040500

Flash from Add Stop

UART SWD
Arhnme liot ~F TR Dmrdes

Lys
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Flash the BlueNRG-2 6/6

1. Flashing starts: green bar proceeding

Dewvice BlueMRG-2 {max flash address: 0x1007ff)

2. Wait for the pop-up window and click on OK

Device BlueMNRG-2 (max flash address: 0x1007fff)

Reading Memory COM91

100%

&7 BlueNRG-1_2 Flasher - Utility

Device Memory COMS1 Image File

A Device COM3IL -> Flashed and Verified.

Start Address  0x 10040000 ! Read Write

v = ;
010040000 00 &0 00 20 D
0:0040010 A4 55 55 A4 45 55 4C 42 00 00 00 00 Q0 00 00 00 GUUSEULE
0x0040020 00 0O OO 00O 0O 00 OO0 OO 00 00 00 00 2 12 04 10 !
0x0040030 00 0O OO 00O 00 00 00 OO D7 068 04 10 23 12 04 10 w & i
Log
##%«5TROT FLASH OPEZRATION*** oL

Flash Boards: COM31 (5T DE)
158:17:231.51Z: Device COM31 -> Flash Programming

‘ 16:17:22.171: Device COMS1 -> Read Board Started
15:17:32.884: Device COM3]1 -> Read Board End

18:17:32_.5317: Device COMS1 -% Flashed and Verified.

life.augmented




SWD: Use BlueNRG ST-LINK Ultility

* On st.com at this link:

https://www.st.com/content/st com/en/products/embedded-software/wireless-connectivity-software/stsw-bnrg1stlink.html

[ STSW-BNRG1STLINK ] = print M Saveto MyST Share via Email

BlueNRG-1 ST-LINK utility for BlueNRG-1, BlueNRG-2 MCU

Get Software Download databrief

Overview Resources

The BlueNRG-1 ST-LINK utility is a full-featured software interface for programming BlueNRG-1 and
BlueNRG-2 devices.

Lys
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https://www.st.com/content/st_com/en/products/embedded-software/wireless-connectivity-software/stsw-bnrg1stlink.html

Programming Embedded Flash
1. SWD interface + ST-LINK

¥ B
8, BlueNRG-1 ST-LINK Utility [E=RE

File Edit View Target ST-LINK Help

Hd @G 2B0 @

Memory display Device BlueMRG-2
P EEETEE— e e —
Address:  0x10040800 - Size: Ox 16FAS Data Width: 32 bits - L
Revision ID Rew 0
Flash size 256KBytes
| Device Memary @ 0x10040800 : | Binary File | [ Livelpdate
Target memory, Address range: [0x 10040800 0x100577A8]
Address 0 |4 E c ASCI -
l : 01 0040800 20006000 10047640 10047931 10047933 o My 1y 3y i:I
GO 0:10040810 AAS555AA | 424C5545 00000000 00000000 EUUZEULE........
(x1 0040820 00000000 00000000 00000000 10047935 e Sy..
010040830 00000000 00000000 100474 4F 10047938 ... Tt..9y..
0:10040840 10047959 100474E1 (00000000 00000000 [ R e st aaanae
010040850 10047965 100474B32 100479C9 100474BF Pyt I—fy epta.
el 0040860 00000000 00000000 00000000 00000000 ..o
0:10040870 (00000000 100474C1 100474C3 100474C5 bt Bt At
(10040880 00000000 100474B5 100474B7 100474B9 coHE ot A8
4| m | 3
03:43:03 @ ST-LINK SN @ 57FF70065088495348330487
03:43:03 ¢ ST-LINK Firmware version : V213157
03:43:03 : Connected via SWD.
03:43:03 : WD Frequency = 4,0 MHz.
03:43:03 : Connection mode : Normal.
-
03:43:03 : Device : BlueNRG-2
03:43:03 : Device family :BlueNRG-2
03:43:03 : Device flash Size : 256KBytes

Lbebug in Low Power mode enabled. ']evice : BlueMRG-2 Core State : Live Update Disabled

life.augmented



Open the ST BLE Sensor App

2 Download on the wll Verizon LTE 17:43 7 © % 99% ) 4

¢ App Store

P> Google Play

Launch the ST BLE Sensor
app previously installed

Connect to a device

Note: in the following slides all the pictures are
m referred to the iOS version of the ST BLE Sensor app. Version- 422

© Copyright 2019 STMicroelectronics.

The Android version is slightly different Al tighes rosonved

life.augmented



Connect Using the ST BLE Sensor App
@ 2 o

Tap Select your You are
“Connect to a device” BlueTile connected
D = .
— o= Blow air on
g the
Look for YOUR oo | oo | Temperature
Local name —_— sensor to
before change the
connecting! l, temperature
N’ and humidity
1013.73 mBar 51.50 % Values
T 5 & o -




* “Device connected” will appear as connection is created
« Each time user moves on different tabs/screens in the app:

Lys
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* BLE notifications on different BLE characteristics are enabled.
 Environmental and Gas Gauge/Battery characteristics are involved

-

v COME] - Tera Term VT

File Edit Setup Control Window Help

i STEUAL-BCHABZU1 Hitd

Scan for sensors:
— Accelerometer and Guroscope: 0K
Pressure and Temperature: 0K

Humidity and Temperature: QK

Magnetometer: OK
— Proximity Sensor: OK
Sensor in low—power mode: OK
Battery voltage is 3.31v: OK
Device iz _now _discaverable with MAC: F7:cl1:18:07:28:8b
[Device connected
Lallbrarlion STartus l‘EEI'I_lEEtEd
Environmental Motification ON

Environmental Motification
Gas Gauge Motification OM

Gas Gauge Motification OFF
Environmental Motification
Environmental Motification




ST BlueMS Protocol mm

In file sensor.c

Len | Type | Frotocel | Device | Feature Device MAC Len | Type | Local Name | Len Type Pwr

389 el e ceaanans ssion rovez| 3 bytes TX output power
3490 T S = = e ey e g e U™ S s gy g Ty e e

391 13, /% Length#/0xFE, Ox01, /% SKD version #7 @@

392 0x05,/* Ox05 BlueNRG-Tile Board */ 9 bytes Local Name
303 #if ENABLE BLUEVOICE

304 : ' Ox6L, f* ADPCM Sync + ADPCM Audio + Led + Prox */

395 felze

396 : 0x22, /* Led + Brox */

397 #endif

308 _ OxFE, /* Bgg + Gyvro + Mag + Press + Hum + Temp + BaLq* 1

200 Bie mumse wormonex 13 bytes Manufacturer Specific

400 005, /* AccEvents + iNemo Compact */

401 Ox40, f* eCompass */

402 felze

403 5 ox04, f* AccEvents */

404 : Dx00,

405 #endif

406 5 ox00, f* BLE MAC start */

407 Dx00, Ox00D, DOx00D, Ox00, Ox00, /* BLE MAC stap */

408 & }

life.augmented



BlueMS Protocol

4 Bytes Complete Feature Mask

Protocol | Device Feature Device MAC Len | Type | Local Name Len Type Pwr

81

version ID Mask

Ox6A

OxFE

0x05

0x40

SensFus | Compass | Motionint Activity  Carry Pos MemsGes ProxGes Pedo

life.au gmenfed



How Feature Mask is Mapped onto ATT DB?

» 3 services: HWServW2ST, Config,
and Console

HWServW2ST

Environmental

- Each bit of the 4-byte Feature ORI L2
Mask in the Advertising packet Acc Event Quaternions
corresponds to a HW/SW feature Battery

- In the Server ATT DB a BLE coret ADPCM Synch
Characteristic has to be added

Console

for each bit of the Advertising Term Char
Feature Mask

STDERR Char

Lys
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BLE SensorDemo ATT DB

= Project: BLE_SensorDemo
—-fa Release
| BlueMRG1_Periph_Driver
1 Platforms_Layers
1 Startup
-5 User

1) BlueNRGL_it.c The ATT DB is defined and
ij gatt_db.c
D semors created in the file gatt db.c

] SensorDemo_main.c
] HWAdvanceFeatures.c
_] hw_config.c

J Hal

1 Stack

J OTA

3 VL53L1X

r "1 MotionFX
” 1 BlueNRG1_BlueVoice_Library
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BLE SensorDemo ATT DB
R
12

N.R 128-bit  001D0000000111e1ac360002a5d5¢51b
20 N 128-bit  00E00000000111e1ac360002a5d5¢51b
5 N R 128-bit  00000400000111e1ac360002a5d5¢51b
9 N.R 128-bit  00020000000111e1ac360002a5d5c51b
. Prox 4 N.R 128-bit  02000000000111e1ac360002a5d5c51b
3 N.R 128-bit  20000000000111e1ac360002a5d5c51b
8 N 128-bit  00000100000111e1ac360002a5d5¢51b
m 4 N 128-bit  00000040000111e1ac360002a5d5c51b
20 N 128-bit  08000000000111e1ac360002a5d5¢51b
6 N 128-bit  40000000000111e1ac360002a5d5c51b

NOTE: two additional bytes for a timestamp for each char



Lys
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Example: Battery Characteristic
--mm-mmm 0x00

ADPCM Switch ADPC MicLevel  Proximity

Gyro Pressure  Humidity = Temperat
“““““ 0x00
Beamform AccEvent FreeFall
-nnnnn BN oxo0

SensFus Compass Motionint Activity  Carry Pos MemsGg ProxGes Pedo

UUID VALUE

HWServW2ST 00020000000111e1ac360002a5d5c51b

The UUID values are linked to

the Feature Mask in advertising




BLE SensorDemo ATT DB mm

Each characteristic is defined by the following key parameters

Console -
N.R 128-bit  00000001000E11e1ac360002a5d5c51b

STDERR 20 N.R 128-bit  00000002000E11e1ac360002a5d5¢51b

/

This byte differentiates the Service

20 N, Ww/oR, 128-bit 00000002000F 11e1ac360002a5d5c51b
R,W




BLE SensorDemo ATT DB

tBleStatus Add_HWSeerZST_Service(void)

aci gatt add service (UUID TYPE,UUID, ..,MAX NB ATTRIBUTES, &ServHandle)

aci gatt add char (ServHandle,UUID TYPE,UUID, Length, PROPERTIES, PERMISSIONS, .., &CharHandle)

HWServW2ST HWServiW2STHandle = 0x000C

— EnvironmentalCharHandle = 0x000D

AccGyroMagCharHandle = 0x0010
!

I I

: |

! !

Config —  ConfigW2STHandle = 0x002B
Config Char —_— ' =
‘_” ConfigCharHandle 0x002C

life.augmented




BLE SensorDemo ATT DB

Char Declaration EnvironmentalCharHandle = 0x000D

&

Environmental
~

- Declaration Handle: used by the application to access the Characteristic

Char Value Handle = 0x000E

Char CCCD Handle = 0x000F

- Characteristic Value Handle: used by the Client for Read/Write operations

* Client Characteristic Configurator Descriptor (CCCD): a GATT
descriptor is added by default by the stack, if char has Notify/Indicate
property. Used by Client to enable notifications/indications on char value.

Lys
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Central: Services and Characteristics
Discovery Procedure

UUIDs Handles

NarE Handle Property Walue Va I ues Walue Length |
4 B Service User Defined (0:0000000
4 Characteristic User Defined) (001 00000000111 E1 AC360002A505C51 B 0b000D Read, Motify IU::ﬂllFUlllDBCUUUlEBQCAﬁUS]UxﬂC
Client Characteristic Configuration Fa) 32
4 Characteristic User Defined ((x00E00000000111 ELAC360002A505C51B) w0010 Motify
Client Characteristic Configuration (0:2902) (0012 (000 32
- - 4 Characteristic User Defined ((:00000400000111E1AC360002A5D5C51B) w0013 Read, Motify 00000002405 005
T h Is Is h OW Client Characteristic Configuration (0:2902) 00015 w000 s,
4 Characteristic User Defined (0:02000000000111E1AC360002A505C51B) w0016 Read, Motify 0xBEA1232E 004
Client Characteristic Configuration (0:2902) 00018 0000 (i
ATT D B 4 Characteristic User Defined ((x20000000000111E1AC3600024505C518) (w0019 Read, Motify 00024 E6 003
Client Characteristic Configuration (0x2902) 0x001E 0000 i
= 4 Characteristic User Defined ((00020000000111 ELAC360002A505C518) 0h001C Read, Motify 00180000 CBADIERABRS 009
I oo ks I I ke Client Characteristic Configuration (0x2902) 0x00LE Ox0000 02
4 Characteristic User Defined (0:00000100000111E1AC3600024505C518) 0001F Motify
Client Characteristic Configuration (0:2902) 00021 (000 32
fro m th e a @ Characteristic User Defined (0x00000040000111E1AC360002A5D5C518) 0x0022 Notify
Client Characteristic Configuration (0:2902) (0024 (000 32
4 Characteristic User Defined ((:08000000000111ELAC360002A505C51B) 0h0025 Motify
C e N t ra I Client Characteristic Configuration (0:x2902) 050027 0x0000 0x02
4 Characteristic User Defined ((x40000000000111E1AC360002A5D5C51B) w0028 Motify
Client Characteristic Configuration (0:2902) 00024 w000 (k2
4 B service User Defined (0x00000000000F11E19AB400024505C51E) 00028
4 Characteristic User Defined ((x00000002000F11E1AC3000024505C518) 0ud02C Write wi/o resp, MNotify
Client Characteristic Configuration (0x2902) 0w002E 0000 i
4 B Service User Defined (0x00000000000E11 E19AB40002A505C51E) 0:002F
4 Characteristic User Defined ((x:0000000L000E11ELAC360002A50D5C51E) 0030 Read, Write w/o resp, Write, Motify O 0
r Client Characteristic Configuration (0:2902) 00032 0000 w2
’, 4 Characteristic User Defined ((x00000002000E11ELAC360002A505C51B) w0033 Read, Motify Ohdd 000

life.augmented Client Characteristic Configuration (0:2902) 00035 (000 32



BLE Sensor — Characteristic Update mm

Central (((9 ))) Peripheral

£ 3 y £
g Bk pRe.v S
(BB, BEEEE e
g B :
) L

Connection created

Notification

11 00 ms

aci gatt update char value (ServiceHandle, 0x000C, //HwWserv handle

(9]

Description Where CharHandle, O0x000D, //EnvChar handle
If notifications (or indications) are enabled Offset 4 0x00 ’
on the characteristic, this APl sends a GATT server Length , 0x08
notification (or indication) to the client. !
m Value) Data) //EnvChar Value

life.augmented



Cortex-MO Sleep Management
Central (((GB))) Peripheral

Connection created * Sleep mode managed through specific a library and API
Notification : * BlueNRG_Sleep(sleepMode, gpioWakeBitMask, gpioWakelLevelMask)

- 4 wake-up sources: timers, DIO11, DIO12 and DIO13
« Timers: 4 virtual timers mapped on 2 physical timers managed by the radio IP
* DIO11: Interrupt line from UART RX or SW1 button

* DIO12: Interrupt line from Magnetometer

I1 00 ms

Radio Active
phase

) Deep sleep mode
N _@ A 10— »

‘— Connection Intervals time
> /4

life.augmented

* DIO13: Interrupt line from 6-axis Accelerometer & Gyroscope




Typical Scenarios

Active mode
Tx/Rx
Low throughput Deep sleep mode
) i
>
. : time
Long Connection Intervals (in the orders of secs)
High thkoughput I8P B & | b b | b
— >
Short Connection time

Intervals (min 7.5msecs)

Active phase

typical plot X
RX —
Start-up
CPU CPU
Active L : - CPU OFF
XTAL RX-2-TX ACtIVG ---------- .
"’ startup & time

LL lock

life.augmented




Low Power Modes

- Deep sleep mode can represent most of the application time.

- Efficient management of sleep mode significantly lowers the avg power

consumption.

BlueNRG-2 flexible low power architecture

Highest pwr

RUNNING
CPU HALT
WAKETIMER
NOTIMER

Lys
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1.9mA
1.5mA
900nA
500nA

Core running
, _ Low Power library combines
WFl instruction requests coming from the
application with the radio

GPIOs and Timer Wakeup operating mode

GPIOs only Wakeup
Lowest pwr



Context Save/Restore

* BlueNRG-2 Low Power Library handles autonomously entering
and exiting to/from the sleep mode.

* The library saves peripherals configurations and application
context before entering deep sleep, and restores the context on
exiting from low power state:

« CPU returns to execute the next instruction after the low power function call
 No need to re-initialize peripheral and radio stack
 RAM retention is guaranteed

NO need for the application to worry about

sleep management and RAM retention!
Lys
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BlueNRG

Current Consumption Estimation Tool

* On st.com at this link:

http://www.st.com/content/st com/en/products/embedded-software/wireless-connectivity-software/stsw-bnrg001.html

[ STSW-BNRG001 ] & print M Saveto MyST Share via Email

BlueNRG current consumption estimation tool

Get Software Download databrief

Overview Resources

The BlueNRG current consumption estimation tool can predict the current consumption under different
conditions, as defined by the Bluetooth low energy specification, for the BlueNRG and BlueNRG-MS
Bluetooth® low energy wireless network processors as well as the BlueNRG-1 and BlueNRG-2 Bluetooth®

r’ low energy systems-on-chip.

life.augmented


http://www.st.com/content/st_com/en/products/embedded-software/wireless-connectivity-software/stsw-bnrg001.html

BlueNRG
96 _

Current Consumption Estimation Tool

* Accurate estimate of average current consumption and battery lifetime

&y BlueMRG Current Consumption Estimation Tool v.1.4 =S e
1. Select the device File Plot Settings Window Help

Calculate Consumption Performance Summary
2. Select the type of Events: |’“““ﬂ | T e e 2.87ms
event W""iﬂﬂ | Coggecton |
Average current during the active phase: 4.9 maA
Type of Device: DE-DC Converter Active
Total average current: 7.93 uA
High Power mode Pout 4(-2dBm) -
Payload data rate: P&
3. Configure the H\W NET 3.0 $  Crystal Startup Time (us) 512 :
operating conditions A Retenonran e - [ sGr0) <] Battery lifetime
/ Battery capacity (mAl 230 =
4 . Configu re the Internal Low Speed Clock [] slave SCA (ppm) 100 =
. . ttery lifeti 3 . 3 th(s), 23 d
application use case ki year(s). 3 month{(s). 23 day(s)
5. Specify the Battery capacity 6. Read the average current and the

estimated battery lifetime

Lys
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Lab 3
LED Characteristic



Enable LED Toggling mem

ooooo Verizon LTE 10:39 @ 7 © } 86% HE)

< Devices m
f 1. Tap the image on the
Click the image to change the status ) Scree n

2. Send BLE notification
packet

Write
Packet

3. Image changes color
and the RED LED
toggles

1" LED ON
‘0’ LED OFF

Notification

Packet
—

1 )

1" LED ON
¥ W ‘0’ LED OFF
A T

viromental Mems SensorFusion Plot Data Cloud Logging More

Lys
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Code Flow mm

. Client enables LED characteristic notifications

Client Writes in Config Char

Parse write command from the client and send BLE notification
on LED status from the server



)
.’E ST BlueMS Protocol

BlueMS 4 Bytes

Type | frowocel | Device) | Feature Device MAC Len | Type | Local Name | Len Type Pwr

ENEREREEEAEEEES

ADPCM Switch DoA ADPC MicLevel  Proximity

N I I T O O ox1E

Gyro Mag Pressure  Humidity @ Temperat Battery 2nd Temp

mmnnnmnn 000

Beamform AccEvent FreeFall SensFusC

7 | 6 | 5 | 4 | 3 | 2 | 1 | 0 [N

SensFus Compass Motionint Activity  Carry Pos MemsGes ProxGes Pedo

Lys
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1.

Client Enables LED Characteristic

Notifications

In the file gatt db.c go to the line 670

2. Client writes in the LED Characteristics Client Configurator Descriptor
(CCCD) and Server enables notifications through the

xFeatureNotification structure in line 673 by
xFeatureNotification.LedNotification = true;

670
67Tl
672
673
674
675
676
a77

678

e

} ElSE[if (attr handle = (LedCharHandle + Ei} {
if (att_data[C] = 01) {
xFeatureNotification.LedNotification = true;]
PRINTF ({"Led OH\n\xr"):
} else if (att data[C] = C) {
xFeatureNotification.LedNotification = fals=se;
PRINTF ("Led CFF\n\xr"™)

}



Client Writes in Config Char

1. In the file gatt_db.c go to the line 806

2. Client writes in the Config Char and Server parses the command through the
function ConfigCommandParsing(att_data, data length)

806 } else[if (attr handle =— ConfigCharHandle + ;i i

807

808 [f” Received one write command from Client on Configuration characteristic 1f
809 ConfigCommandPar=sing(att data, data length):

810 - -

811 - }

life.augmented



Parse Write Command And
Send BLE Notification on LED Status

1. Infile Sensor.c at line 1040 =) é] “acc FEATURE MASE LED:
2. Check on the FeatureMask (line 1046) 1154
3. Ifit's the LED feature mask (line 1152) EE %ﬁl}ﬁ.ﬂuhfy?mﬁﬂéﬂm Command, Dath)
4. Check on the command value. If 0x01 (case1) |.... O S EvalledOfs (LEDL) ;
5. Turn ON LED3 E Eﬂ;ﬂéﬁiiiiﬁﬁﬁiﬁég&D, Command, Data)
6. Send Notification on the Config char on the g; [ !

command received and parsed — e B L reepareton ioanon Ledier Dcenion))
7 send Nottfteat; r..;latr;;ﬂﬂ CDﬂflECDIuI::landiaIplnaF'.:g:l‘lt-_tpg:i ::q Elsw

LED statys .- winto s Data — act asvars); (NN y | eenemRERy

10494 uint32 t SendItBack = 1; 1172 break:

gswitch (FeatureMask) ]

life.augmented



Enabling LED Toggling

Click on “Switch” A new page will appear

eee0C Verizon F 14:12 @ 7 3R 72% @) #8000 Verizon F 14:15 @& 7 % 71% W

< Devices ﬁ < Devices m

Click the image to change the status

0.00°C
26.30 °C

Not Present

NS

0.00 mBar 52.40 %
‘ & & O =
” Envi;o.menta\ Plﬁta Cloud Loggigy 9\ ﬁ o Q

life.ougmenfed Enviromental Plot Data Cloud Logging Switch Rssi & Battery




Enable LED Toggling

ooooo Verizon LTE 10:39 @ 7 0 3} 86%
< Devices m
N o
Click the image to change the status J)
Write
Packet ® aim
— 0
‘1’ LED ON
‘0’ LED OFF
Notification
<22t _ 1. Tap the image on the screen
1"LED ON 2. Send BLE notification packet
# % & o - | OLEDOFF
3. Image changes color and RED LED
17

toggles

life.augmented



LED Fast Blinking Due to Sleep Mode

 Red LED fast toggling shows the entering/exiting to/from Sleep mode

k
Connection Intervals

1@ | L —

Deep sleep mode

T 1

In Active Phase In Sleep Phase
LED is ON LED is OFF

life.augmented



« String “LED Notification ON” will appear as the app tab is enabled

« Each time user click on the LED icon in the BLE Sensor app, the
Write command is sent to the board and the LED toggles
accordingly ("Enabled: RGB led” = ON, “Disabled: RGB led” = OFF)

Device i1s now discoverable with MAC: 3f:2c:f6:eb:da:-d8
Sensor activated: 0K

Device connected
Environmental Motification ON

Fnuivrnnmental WNotification OFF

ILed Motification ON
Enabled: RGE led
Disabled: RGB led

107




Lab 4

Accelerometer Embedded Events Detection



Example - Single Tap

1. On the board perform a
(((9 ))) Single Tap

. Send BLE notification
packet

Event Enabled: Single Tap

Notification

Packet
—

‘SINGLE TAP’

NOTE: this is just an example
for SingleTap. Other events will

Kys be displayed later in the lab!

life.augmented



4

BlueMS

Protocol

Type version

4 Bytes

Device
ID

Feature
Mask

Device MAC

ST BlueMS Protocol

Len | Type

Local Name Len

Type Pwr

Lys
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Acc

RFU

ADPCM

Gyro

RFU

SW|tch

DoA

RFU

ADPC

MicLevel

Proximity

20 | 19 | 18 | 17

Pressure

Humidity

RFU

Beamform] AccEvent

Temperat

Battery

|2nd Temp

FreeFall

SensFusC

7 | 6 | 5 | 4 | 3 | 2 | 1 | 0

SensFus

Compass

MotionInt

Activity

Carry Pos

MemsGes

ProxGes

Pedo

0x20

0x9E

0x04

0x00



-
& - LSM6DSO at a Glance

1. PERFORMANCE AND FEATURE 2. FLEXIBILITY: algorithm @ silicon level
Accuracy: Tango and Daydream compliance  gw = ?_1‘._]__;1;%_] * Pedometer 2.x
0.55mA current consumption is HP combo r—n@_ 5 WeChat Precision

-15% vs. LSM6DSL/M @ same performance

vew Ultra low power mode: LSM6DSO _ |
14uA (@100Hz ODR) AxI only == FSbeIg( custom
|°_h|?| N Gyro

4. INNOVATION

« MEMS: Axl T-structure for mechanical
shock robustness

« Compressed FIFO (3x)

* FIFO tag * 10 patents protecting LSM6DSO
innovation

2.5x3x0.86 mm




Client Enables Acc Event
Characteristic Notifications

1. Inthe file gatt_db.c go to the line 703

2. Client writes in the Acc Event Characteristic Client Configurator Descriptor
(CCCD) and Server enables notifications through the xFeatureNotification
structure in line 714 by xFeatureNotification.AccEventNotification = true

} else[ if (attr handle == (AccEventCharHandle + Z}) { ]
if (®FeatureNotification.MotionNotification = false && XFeatureNotification.iNemoEngineMNotification == fals=se) {
i ol L i

1sm6d;n_xl_data_rate_set {0, L5MeD50 XL ODR 52Hz):

OFF

— . S
EnableHWMultipleEwvents () ;

J P A
711 'GPID_ExTIcm:GPIo_Pin_13, ENABLE) ; !
T12 onfig Notify 2 5, 'm", 1);:

13
T1l4
T15
T16 } else if (att datal[0] = 0) {
== l=smédso_x1 data rate set (0, LSMeD50 XL CDR _OFF) ;
‘ .__" xFeatureNotification.AccEventNotification = false;
" ric GEIC EXTICmd (GPIC Pin 13, DISAELE) :
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Read Event Status and

1288 [[Jvoid MEMSCallback(vpid) {

Send BLE Notification

1300
1301 ‘ [ lsméedsoc all sources get -ﬂ: » &all source);
1334 f* Check if the interrupt is due to S5ingle Tap */
1335 %—% if dwareFeaturePresence . MultipleEvent) {
1336 = if (all suurce.reg.all int src.single tap)
1337 SdkEvalLedCOn (LED1) ;
1338 SdkEvallLedCn (LED3) ;
1339 PRINTF ("Event: Single Tap'n\r"}):
1340 LocEvent Hotify (ACC SINGLE TAP, 2 .
1341 i } - e — In the flle sensor-c
1342 e } . - .
1242 1. line 1299 void MEMSCallback(void)
Callback triggered by 1013
2. line 1301 Ism6dso_all_sources_get
Read accelerometer status registers
3. line 1336 if (all_source.reg.all_int_src.single_tap)
Check vs. single tap event
4. line 1340 AccEvent_Notify

Lys
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Send BLE notification



Visualize Single Tap Event
in ST BLE Sensor

€ Devices ﬁ Se Ie Ct

" Tap "Single Tap” Enabled
i Select “Event Enabled” and hit“Select”  “Single Tap”

11 b
c c Ve n wecco TIM B 8:53 BM TH oSN e Verizon & 10:21 @ 7 } 85% mm) 10:21 @ 7 % 85% W)

£ Devices |'T_'| Select the event to detect < Devices M

27.60 °C Not Present

!

N’

1024.14 mBar Not Present

Event Enabled: Single Tap

Event Enabled: Wake Up

Multiple

Single Tap

UOURIC Tdp

o & ol =

Enviromental Plot Data Cloud Loggirlh  Acc Event More
~
~
1 Sso
~
] S
] S
~ Select
~ i o Ly e e =
II Sso - W e g Cancel » i [+ -
I NN Envircemantal - Sersor Fuson PAX FeatueAchey Recogrlion. More Enviromental  PlotData  Cloud Logging  Acc Event  Rssi & Battery
ﬁ ~N~
N
W1y A
id )
Enviremental Plot Data Cloud Logging UAGE Event Mare




Event Detection

1. On the board perform a
Single Tap

2. Send BLE notification
packet

Single Tap

¢ Devices M

((( ))) EEEEEEEEEEEE : Single Tap

Notification
Packet

—
‘SINGLE TAP’

S =
& O =
Enviromental Plot Data  Cloud Logging  Acc Event  Rssi & Battery




Tera Term Output

VT COMS1 - Tera Term VT

« “AccEvent Notification ON”: b _
enable notifications on the File Edit S5etup Control Window Help
oy AccEvent Motification OFF
Accelerometer Event characteristic [((EEErpa A EeFcIms

L Th Ll
LY== LPLF AL J.I.T-IIL-EI.I..-J.UII

° “Enabled Slngle Tap Detection”: Dizabled: Multiple Event Detection

Enabled: Sinale Tap Detection

i lEvent: Single T
user enables Single Tap event Event: Sinale Tan

detection Event: Single Tap

+ “Event: Single Tap”: the actual
BLE notification packet is sent
upon detection of the Single Tap
event.

‘7’ NOTE: if the phone display enters sleep mode, the notifications are not sent

life.augmented



LSM6DSO Embedded Events

Other possible
embedded events

®eec0 Verizon T 10:21

@ v 3} 85% mm)

Select the event to detect

Free Fall
Single Tap

Double Tap

Select

Cancel

Lys
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No event

A S
g

652 M 74 S

+
]

Bl A B

Free fall

5 % 95% m_

Single tap

< Devices ]

Wake up

Pedometer

>
1

|

e

05%

=

o & @ g e

# w @ g e

53 e
< Devices |
Event Enabled: Pedomater

W @ g o

WakeUp
example




Visualize Hardware Wakeup Event
in BLE Sensor

peooo TIM 2 B:53 PM T § G95%

£ Devices |'T_'|

ooooo Verizon LTE 16:35 @ 79 % 77%mm)

< Devices ﬁ

Event Enabled: Wake Up

2 Select
¥ “Acc Event”

27.60 °C Not Present

<

1024.14 mBar Not Present
K i i
# & o » |
Enviromental Plat Data Cloud Loggi Acc Event More
S
] Sso
] S
~
1 SN
~
1 SS
1 S
~
1 S
~
1 SN
ﬁ So
N;

» e oW @

Ay Merlonn Maore

&y7 o & O | =] -

Enviramental Plot Data Cloud Legaing Acc Event hare
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Event Detection

1. Leave the board still for a few seconds
2. Shake the board
3. Send BLE notification packet

Wake Up
'(";::ic:; - * 95%5‘
Notification
Packet
—
‘WAKE UP’

d' TS o .‘-' @ T
Envirceantal Sersor Fuson U040 Featy redohey Remrien  More




120

Y COMS1 - Tera Term VT

« “AccEvent Notification ON”: enable — —
g . File Edit Setup Control Window Help
notifications on the Accelerometer Event I ——
characteristic _ Notif ication ON

: bD Urientation
Dizahled: Multinle Fuent Detection

« “Enabled Hardware Wakeup”: user fEnabled: Harduare Yakeup
enable hardware wakeup event detection  Homduare Ualeu
: Hardware Uak
. “Event: Hardware Wakeup”: the actual : Hardware Wakeup
BLE notification packet sent upon e Walcup

detection of the Hardware Wakeup event. : Hardware Wakeup

Hardware Wakeup
Hcchent Motification OFF

Lys
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LSM6DSO Embedded Events

You can go ahead later and test other events...

Other possible No event

7% oo 4 o

Free fall Single tap

b d d d t < Devices i} < Devices ] < Devices il
e m e e eve n S Select event Event Enabled: Free Fall Event Enabled: Single Tap
----- ™M @ 6:52 PM 7} 95% mm)
Select the event to detect |
® = %
Double Tap
Wake Up Wake up Tilt Pedometer
T\ft e0ssoTIM B 653 PM 95k m. wa TIM B 8:53PM 4 95% . weoo TiM @ 8:53 PM 7§ G5k m.-
Pedometer ol t i 0 S u
nt Enabk

B

Cancel
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Lab 5

9-axis Acc+Gyro+Mag Sensor Data Fusion
Lys
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Goal

* In this example we are going to demonstrate how to:

- Enable the embedded sensor data fusion library
 |Input: raw Acc+Gyro+Mag sensor data
« Qutput: quaternions

« Scale the quaternions value by a scaling factor proportional to proximity
detection

« Send scaled data fusion information through BLE notifications packets
to the ST BLE Sensor app client



Sensor Data Fusion

. Enable Sensor Fusion

(@)

Notification

Packet
—

QUATERNIONS |

Sensors used by data fusion:
Acc+Gyro+Mag and Proximity

library

. Send quaternions

information through BLE
notification packet




Code Modifications

. Enable Sensor Data fusion library

Enable proximity sensor

Send quaternions data — scaled by proximity sensor data -
through BLE notifications packets



)
.’E 4 Bytes ST BlueMS Protocol

BlueMS

Protocol | Device Feature

Type | \ersion D Mask Device MAC Len | Type | Local Name | Len lype Pwr

ADPCM| Switch | ADPC Mchevell Proximity Lux

20 | 19 | 18 ] 17 OXFE
Gyro Mag

Pressure  Humidity @ Temperat Battery 2nd Temp

0x22

0x05
RFU

SensFusC

4 | 3 | 2 | 1|0 [N

SensFus Compass MotionInt Activity  Carry Pos MemsGes ProxGes Pedo

Beamform AccEvent FreeFall

life. ougmenfed



Sensor Data Fusion
(1) 2] ()

Swipe left to view the “Mems Sensor Click on Sensor Fusion
Mems Sensor Fusion Fusion” tab OK enabled

ssc00 Verizon LTE 10:42 @& ¥ ¢ % 85% mm) #0000 Verizon L TE 10:39 @ 7 0 3} 86% W) ‘ #0000 Verizon LTE 10:40 @ 7 0 3} 86% W)
£ Devices ih £ Devices U < Devices LT]
- ‘ 7
% i ’ !I
i - -2 ~
-
S Not Presert { ‘,7 To calibrate, move the board as
3250°C ‘ - shown in the image k
—
To calibrate, move the board as Ok
hown in the image l J
' Ok

1013.73 mBar 51.50 %

o v & O - » =w & O o W @ o -
al MemsSerserfuson  Plot Data Cloud Logging More. Enviromental Mems Sensor Fusio Plot Data Cloud Loge Enviroment: sor Fusion ot Data Cloud Loge




Enable Proximity
_Sensor

life.augmented

@ 7 0 3} 86% W)

=

evices

Proximity Sensor
@ ©

Far from Near to
BlueTile BlueTile
il G 00 0@
Move your
hand far and
close to the N
BlueNRG-Tile
¢ Ve < v
L. 4 O - ¥ % @ o
2 2

Note: ONLY for rendering purposes, the cube is scaled
proportional to a clipped 30 cm distance



Proximity Sensor - VL53L1X

3rd gen ToF sensor with lens for long distance ranging & ROI selection

Product highlights

OLGA:4.9x2.5x1.56 mm
FoV : 27°
Compatible footprint with VL53L0X

Enhanced performances:

* Full FoV ranging : 400cm+ (white target, no IR)
Programmable FOV: SPAD zone selection — full-screen to 4x4

Cutting-edge module and silicon :
+ Fastest miniature ToF product in the market up to 50Hz

+ Integrated lens for longer range and better ambient light immunity
* Programmable settings to best fit customer’s application:

» Low power with interrupts for user / object detection
» Long distance ranging
» High accuracy for small movement detection

Applications

Presence user detection

* Autonomous mode with interrupts

* Low-power

* Long distance 400cm+

+ PC, tablets, loT, portable handsets, security

Obstacle detection:

* Robots: Obstacle avoidance

* Vacuum cleaners: Wall following, cliff detection
» Drones: Take-off and landing, Ceiling detection

Accurate objects distance scanning
* Vending machines: control of objects in racks
« Coins dispensers: coins counting

* Smart shelves: Consumer scanning

Lys
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Full-range Proximity Real-time Data Plot
@ 2 @ @
“Plot Feature” Select Selectthe  Viewthe
real-time

Swipe left to view the
real-time data plot tab Proximity time frame
data plot

@703 71%m

TE 10:40 @ 7 0 % 86% W eeeco Verizon LTE 09:36 @ 7 % 96% m-: ss800 Verizon LTE 15:16 @ 1o 1% ®sec0 Verizon LTE 09:36 @ 7 } 95%
i i Devic i ; Devices T
£ Devices M < Devices O Select the feature to plot Select the time scale < u
Select Feature Stop plotting Proximity
g
= Accelerometer §'
a [
ol Proximity 5s 5 °
3 2
12
z
H
s 5 £ B B 5 Proximity (mm)
©Proxim (v Select Select Ts:64308 Proximity:104
< - pa: b : 000
& #9 i O o00 » a [+ - LY Cancel Cancel » B al o
e SR RN Enviroments Plot Data  Cloud Log Acc Event  Rssi & Battery Enviromental Mems SensorfFusin  Plot Data  Cloud Loggins More
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Logging Real-time Data Plot
o i o o

_ After some time
Click on Select re-click on the Select App opens your

top right corner “Start 1ogging” (ight-top corner Stop logging”  email client

eseco Verizon LTE 09:37 ERZ] ssxgay | | |

eesco Verizon LTE 09:37 @ ¥ } 95% mm) ®0c00 Verizon LTE 14:26 @ 793 58%m
< Devices m < Devices ﬁ Cancel [ST BlueMS] Logger data
Stop plotting Accelerometer Stop plotting Accelerometer To:
2 @ Cc/Bcc:
: H
Subject: [ST BlueMS] Logger data
i1 “\ ‘
5 | | 5 1
3 / 2 2 20180319_1...rometer.csv
(& [ Start Logging 8 Stop Logging
; | ?
‘ Show Debug Console Show Debug Console i
" ‘\ " 20180319_...rosco pe.csv
g | | License Manager g License Manager
k + + “ + Firmware Upgrade ! ¢ + - p Firmware Upgrade i
g g E g g g g g
_— e ez — =Y =2 20180319_1...rome ter.csv
Settings Settings
Ts:44136 X: 269.00 (mg) Y: 220.00 (mg) Z: Ts:44136 X: 269.00 (mg) Y: 220.00 (mg) Z:
-695.00 (mg) -695.00 (mg)
* & O - Cancel * & O = Cancel i
En-,‘wr‘o‘mtn:a\ Plot Data  Cloud Logging  Acc Event  Rssi & Battery. Em‘m‘o‘n‘vn:al Plot Data  Cloud Logging  Acc Event  Rssi & Battery W

m .csvV files attached

to the email
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Sensor Data Fusion

Sensortuson  Try static position: no drift, the cube is perfectly still

®c000 Verizon

nabled
e * In steady static position the acc and mag enable an accurate orientation
estimate
 acc vibrations and mag bias and interferences are rejected or

compensated by the motionFX library

Try highly dynamic motion: perfect tracking
In high dynamic motion the acc cannot be used, therefore the gyro is used to
update the orientation

“| e+ qgyro bias is estimated and compensated at runtime by the

> & o - . _
P motionFX library

(@]
3
=
Q



Sensor Data Fusion
MotionF X Library

-5 User

] BlueNRGL it.c
|j gatt_db.c
Ij SENEOr.C

» =Y Roll, Pitch
MotionFX [ 4 OQuaternion

Magnetometer » » Heading
Sensor
Fusion » Gravity Vector
» » Linear Acceleration
=55 BlueNRG1_BlueVoice_Library
r - Ij bluevoiceADPCM_BMNRG1_100_Keil.lib
) /4

life.augmented

|j SensorDemo_main.c
Ij HWAdvanceFeatures.c
E-Cd Hal

=5 Stack

------ |j libbluenrgl_stack.a

%_hl stack_user_cfg.c
- |j libcrypto.a
&-EJ OTA

H-Ed VLS3L1X

=5 MotionFX
|1 MotionFX100_CMOP_Keil_ot.lib




Sensor Data Fusion

MotionF X Library

» Roll, Pitch

MotionFX [ 2

=

Y ey vecor
=

- Accelerometer gives roll and pitch angles and the gravity
vector...but only in static conditions! (or low dynamics)

life.augmented

Accelerometer »

=

Sensor
Fusion




Sensor Data Fusion

MotionF X Library

Yaw

=

MotionFX [ 2

- I
=

Accelerometer »

Sensor
Fusion

Magnetometer »

=

=

- Magnetometer gives yaw angle and heading
...but only if tilt is compensated: the accelerometer is needed!
...and magq bias (hard-iron) must be compensated!

life.augmented




Sensor Data Fusion

MotionF X Library

BN Rol. Picn | Yu
e oo
- BTN
= T
Y rear osoraton’

- Gyroscope gives the new orientation based on previous orientation
...but gyro bias offset needs to be compensated for accuracy!

MotionFX

Sensor
Fusion




Sensor Data Fusion
MotionF X Library

» —Y Roll, Pitch
MotionFX 4  Quaternion B

Eld . R
Fusion » Gravity Vector
» » Linear Acceleration

Motion FX library provides orientation estimation plus:
- Magnetometer hard-iron offset compensation.

- Accelerometer vibrations rejection.

+ Gyroscope bias offset compensation. e o

Lys
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The gyroscope is the most important sensor in the system
..works in highly dynamic conditions when the Acc cannot be used
..works with magnetic anomalies when the Mag cannot be used

Gyroscope

LSM6DSO is an inertial module with Acc and Gyro

« Exceptional noise performance for maximum

accuracy in orientation estimation
* 90 ug/sqgrtHz acc noise density
« 3.8 mdps/sqrtHz gyro noise density

« Extremely low-power

650 uA peak power at ODR 6.66kS/sec with
Acc+Gyro in high performance mode!

Lyy......

LSM&DSO

INEMO inertial module:

always-on 3D accelerometer and 3D gyroscope

L3AHL
3 x 0E3 mew By

S .

Features

«  Power consumpdon: 0.55 mA In comba high-

+ St FIFO up to O kbyis
*  Android comgilant

* 22048016 g Rl oA

* 1257225004 5004100042000 dps full sCale

+  Anaing supply voliage: 171V o 36V

+  Independent IO supply (1.62 V)

+ Compact footprint 2.5 mm x 3 mmx 0,83 mm

*  SPIFPC & MIFIZCEY serial intesTace with main

processor data synchmonization

«  Auxdiany SP1 for OIS data output for gyroscope and

accelerometer

s Advanced pedomeder, siep debacio and step

Counier

= Significant Modion Detection, TR detacton
= Standard |

: free-fall, wakeup, G040
orientation, click and moudie-cick

= Programmabie finke state machine: accelerometer,

QyTosCope 3nd extemal sensors

»  Emibedded lemperature sensor
+  ECOPACK® RoHS and “Green compilant

Diata brisf

Description

The LEMEDS0 15 & SysiEm-n-package faaturing a 30
dightal accelerometer and a 30 dighal gyrmscops
boosting pesformance at 0.55 mA In high-performance
mode and enabling always-on Iow-powes features for
an optimal motion experience for the consumer.

The: LEMEDS0 SUPROrS main OF requirsments,
offering raal, virtual and batch sensors with 9 kbyiss for
dynamic data batching. ST's famiby of MEMS sensor
mcukas Iverages the roowst and mature
mMarfaciuring processes aready usad for the
production of micromachined accsikmmeters and
gyroEcopes. The Vanous Sensing slements are
manufactiured wEing specialized micromachining
processas, wilke the IC Iniertaces are developad using
CMOS tachnology that alows the design of a dedicatad
clrcult witkch I SHmmed o better miatch the
characienstics of the sansing akament

The LEMEDS0 has 3 full-soake acoeleration ranga of
£2724550316 g and an anquiar rate range of
125042507 25002 100022000 dps.

The LEMEDS0 fully supports EIS and OIS appiications
a5 the modulke INCluges a dedicated configurabie signal
processing pam for O and awiiary SPi, configuratie
for Dot the gymscope and acosleromater.

High robustress to mechanical shock makes the
LEMEDSCO the prafemed choice of system desigrers for

the ereation and manufacuring of relale producis. The
LEMEDS0 Is avallable In a plasticiand gid amay [LEA)

packags.
Table 1. Device summary

Lys
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LIS2MDL is digital Mag

« Exceptional noise performance and
dynamic range for maximum accuracy in

orientation estimation
« 50 Gauss dynamic range
* 3 mgauss RMS noise

« Embedded offset compensation
* Intrinsic offset is estimated and compensated
automatically
» Extrinsic offset (hard-iron) must be estimated by
host and can be compensated internally

Lys

life.augmented

Magnetometer

Lyy......

LIS2MDL

Digital output magnetic sensor:

ultra-low-power, high-performance 3-axis magnetometer

.

LGA-12 2.0x2 0x0.7 mm}

Features

= 3 magnetic field channels

= 150 gauss magnetic dynamic range

= 18-bit data output

+ SPIPC senal interfaces

= Analog supply voltage 1.71 Vo 36V
=+ Selectable power modefresolution

= Single measurement mode

=+ Programmable interrupt generator

» Embedded self-test

= Embedded temperature sensor

+ ECOPACK®, RoHS and “Green” compliant

Applications

= Tilt-compensated compasses

= Map rotation

= Inteligent power sawving for handheld devices
= (Gaming and virtual reality input devices

Datashest - production data

Description

The LIS2MDL is an ulira-low-power, high-
performance 3-axis digital magnetic sensor.

The LIS2MOL has a magnetic field dynamic
range of £50 gauss.

The LISZMOL inchudes an FC serial bus interface
that supports standard, fast mode, fast mode
plus, and high-speed (100 kHz, 400 kHz,

1 MHz, and 3.4 MHz) and an SP1 serial standard
interface.

The device can be configured to generate an
interrupt signal for magnetic field detection.
The LIS2MDL is available in a plastic land grid
array package (LGA) and is guaranteed to
operate over an extended temperature rangs
from -40 *C to +85 °C.

Table 1. Device summary

Tamp.

Part murnber rangs [*C]

Package | Packaging

LIS2MDL 4010 +685 | LGA-12 T3y

LISIMDLTR | 4010 +85 | Loaqz | ToReaNd

res




Magnetometer

Calibrati
LI % *c000 Verizon LTE 10:39 @ 7 0 } 86% " ®e000 Verizon LTE 12:28 @ 793 70%
1 R
< Devices il < Devices [ < Devices ™M
To calibrate, move the board as
shown in the image k
Ok

# & & o # % &4 o N~

Move the BlueTile with the “8 o
Calibration is Completed

Ve pattern” shown in the figure to _
Tap calibrate the magnetometer when the icon becomes green.
Kys
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Magnetometer ECompass

eee00 Verizon LTE 15:20 @ 7 © % 83% W} #eeco Verizon LTE 15:20 @ 7 9% 83% M #0000 Verizon LTE 10:41 @ v @ 3 g5% W)
£ Devices M £ Devices i £ Devices i
‘ : L ]
== Acc Event = Acc Event Rotate th e B I u e I I Ie
] i ] i
B switch = Switch Orientation: SE
o Compass o Compass ]
Rssi & Battery Rssi & Battery
Angle: 135.92 [Vl
o ® & o - ¢ & & o - ¥ w @ o
Errdfamental M SistrRrin | Piovbatal | Cloud iagging bibrn Enviromental MemsSeneorfusin_ Plot Data__ Cloud Logaing ___ More o ;

(you can check against the

1 Red arrow is related to phone eCompass)

— Select antati
Tap the current orientation

ore “Compass” of the BlueTile

life.augmented



Lab 6

Cloud Data Logging on IBM Watson
Lys
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Cloud Logging

1. Enable IBM Watson loT — Cloud Logging
2. Send BLE notification packets on Sensor status
3. Visualize the data

oooooooooooo = 10:5 @713
< Devices ['1‘]
? — T_—-_-_? Select the cloud provider
— = — T IBM Watson loT - Quickstart ((( )))
\ ’ IBM Watson loT
r Azure IoT - ST Web Dashboard N otifi catio n
Azure loT P
ackets
Generic MQTT
IBM Watson

Aws loT

KLy ¢ SN .=

Enviromental Plot Data i Cloud Logging lAcc Event  Rssi & Battery

life.augmented




IBM Watson loT Quickstart

2. Select “IBM Watson 1. Selectoneor —

loT - Quickstart”

Click “Connect”

#0000 Verizon 10:50 @ 7 } 84% mm)

< Devices [’ﬁ

Select the cloud provider

IBM Watson loT - Quickstart

IBM Watson loT

Azure loT - ST Web Dashboard
Azure loT

Generic MQTT

Aws loT

1. select “Cloud
Logging”

viromental Plot Data Cloud Logging @ Acc Event  Rssi & Battery

#9800 Verizon LTE 15:46 @ 703 69%m)

< Back IBM Watson loT - Quickstart

Device Id

BCN-034_571EBF

Connect

Enviromental Plot Data Cloud Logging  Acc Event Rssi & Battery

multiple features

seecc Verizon LTE 15:51 @ 70 3 69% >

< Back IBM Watson IoT - Quickstart

Device Id

BCN-034_571EBF
Disconnect

Battery

Temperature 0

Wait a few seconds

A

Humidity

Pressure

Accelerometer C <

View Data on Cloud

& O = @

Cloud Logging  Acc Event & Battery

Click “View Data
on Cloud’

scoco Verizon 7 10:52 @ 7 3 83% W)
< Back Cloud Data
(-
N
o =~ < - (1]
Enviromental Plot Data Cloud Logging Acc Even Rssi & Battery




IBM Watson loT Quickstart

Quickstart will You will see the Plot  Table of available
appear of selected feature features

®ec00 Verizon LTE 16:54 @ 7 R 72% > #0000 Verizon LTE 16:54 @ 7 % 72% == #0000 Verizon T 10:52 @ 7 % 83% mm) #0000 Verizon LTE 16:55 @ 7 % 71% mm>
< Back Cloud Data < Back Cloud Data < Back Cloud Data < Back Cloud Data
= Blue034_C3BED5 15 Blue034 C3BED5
IBM Watson loT Platform = I B : | s Blue034_C3BEDS
) 104
® Last message received at 4:54:57 PM ® | ast message received at 4:55:22 PM
B Quickstart |
UICKS o
No sign-up required to see how easy it is to connect Blue034_C3BED5 Accelerometer.Z TTTTTT T I T I T T T T T T T I T I T 7T T oI Blue034_C3BED5 Temperature.Temperature
3 2 & 10:52:21 10:52:31 10:52:41
your device to Watson loT Platform and view live
sensor data
7 Event Datapoint Value 7
Blue034_C3BED: 600 28.9 o
/ \
400 + Accelerometer  Z -1021 o i \
® Last message received at 4:54:31 PM 200 1 4
S c rO I I d OW n o+ Accelerometer Y 12 28.7 - f'/ ¥
| \
200 " [ \
to see yo ur 20 Accelerometer  Timestamp 67589 26 [ \
-400 | \
Blue034_C3BEDS 282 / ‘
ue034_ Accelerometer.Z Se I e C te d -600 | Accelerometer X 31 [ \
-800 - 28.4 ‘ —e
S e n SO r p I Ot 1000 4 Temperature Timestamp 67600 28.3 ;"
S #1200 Temperature Temperature 29.2 282 f—e—o—s—o—od
-1400 T T T T 1T T T T 1T 1T T T T 11 — T T T T T T T T T T T T T
16:54:40 16:54:46 16:54:53 16:55:06 16:55:12 16:55:19
-500
I've seen my data, what next?
-600
. ~ Event Datapoint Value Event Datapoint Value
o = o & O = @ & & o =
Plot Data  Cloud Logging Acc Event  Rssi & Battery Enviromental Plot Data Cloud Logging  Acc Event  Rssi & Battery Plot Data  Cloud Logging Acc Event  Rssi & Batter) -T“,‘r‘rfrvsrt; Plot Data Cloud Logging  Acc Event  Rssi & Battery

Scroll down again to
change sensor data or axes



Lab 7

Voice over BLE

Lys
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* In this example we are going to demonstrate how to:

- Enable the BlueVoice library for Voice Over BLE streaming

* Input: raw data from the MEMS microphone
* Output: ADPCM data streaming @8kHz

« Send ADPCM data through BLE notifications packets to the
ST BLE Sensor app

Goal



Lys
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eooco Verizon LTE 10:42 @ v @} 72% W)

£ Devices m

Codec: ADPCM
l l ©
6 kHz

Volume:

Beam Forming:

bbbt — g

BlueVoice Library

1. Enable BlueVoice library

2. Send voice to the ST BLE Sensor app client
through BLE notification packet

N
‘R? AN o
/ iw Y/ A N
RL 28 g X
/ R €28 SN 1 TR
i g ) | Rl 2 &
<. " - M IN2) ci8 .
Sl 3 3
/ c1s§ / Py 0 i~
Su1. > & ol Y
" -
S C L2 i arafl > - “Ci7mr-\ s
& ‘(‘3 { QM
oo Rg 4 e
c4C8
F !

Notification
Packet ( ( (
—
ADPCM S\
compressed audio MEMS

Microphone



4

BlueMS 4 Bytes

Feature

Type

Local Name

| ADPCM Il Switch | | ADPC |M|cLeveI| Proximity Lux

mmnmnn

Temperat

Pressure

Humidity Battery 2nd Temp

Beamform AccEvent FreeFall | SensFusC

MemsGes

MotionInt ProxGes

SensFus

Compass Activity  Carry Pos

life. ougmenfed

ST BlueMS Protocol

Device MAC

Ox6A

OxFE

0x05

0x40

Pwr



Enable BlueVoice Library
Add the preprocessor symbol ENABLE_AUDIO to the project

1. Right-click on Release
2. Select "Options for Target ‘Release’...”

E CABlueMNRG_Tile_HandsOn\STEVAL-BCHNO02V1 DE 3.0.04ElueMNRG-
File Edit WView Project Flash Debug Peripherals Tools

NEdd|: od|9c|e|prn
@ L| Fi| Release Ela@i\| ﬁ
Project o [

=% Project: BLE_SensorDemo

- Rel
|: E % Options for Target 'Release’... Alt+FT7

SR
Add Group...
E: ﬁ
Manage Project ltems...
B d i
B Open Map File
ol Open Build Log

& |ﬂ| Rebuild all target files

r E %] Build Target F7
/4 ol

| v | Show Include File Dependencies
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Enable BlueVoice Library

In the project options:
1. Go to the tab C/C++ and then in the Preprocessor Symbols

2. Set the symbol ENABLE AUDIO=1 and then click on OK

rﬂ Options for Target 'Release’ - - u
Device I Target I Output | Listing | ser , CC+ |'3\sm | Linker | Debug I | kilities I
— Preprocessor Symbaols

Define: I%:SMF‘S_INDUCTOH_'I&JH SEND_N_QUATERNIONS=1 ADC_2411=1 DEBUG=1§=1=1 88

Undefine: I
— Language / Code Generation
I~ Execute-only Code I~ Stict ANSI C Wamings:
Optimization: ||_eue| 303 [ Enum Container always int |Al Wamings |
¥ Cptimize for Time [™ Plain Charis Signed ™ Thumb Mode
™ Split Load and Store Multiple ™ Read-Only Posttion Independert ™ No Auto Includes
¥ One ELF Section per Function [T Read-Write Posttion Independert W C99 Made

lng:tﬂe I..\..‘u’nc;..\...\..\..\..\mew\ElueNHG1_F'eﬁph_Dﬁver‘Jnc;..‘\..\...\..\...\mew\CMSIS\Deﬂce\ST\BIu: J
5

Misc I
Contrals

—59 ¢ —cpu Cortex-MD g 03 Otime —apcs=interwork —split_sections -l ../, /inc -| -
A fLibrany/BlueMRG1_Periph_Driver/ing -l

Compiler
control
string

, ’ QK I Cancel Defaults Help

life.augmented




BlueVoice: Voice over Bluetooth LE

Select Speak close to e @%@@ .

%2

BIueV0|ce the BIueNRG Tile _; i xxxxxx g (((

0000 @ 79} 71% M . © %} 71% W} @ 7 @} 72% W}
¢ Devices M (D eeeeee M (D eeeeee |ﬁ
®  Acc Event . Acc Event
#  switch i Switch gOdeT A[f)pcMS . " M E MS
$9 Bluevoice $9 Bluevoice ] \;Ei‘::g b s . .
*'J SpeechToText *'l SpeechTaoText Beam Forming: Mlcrophone
o Compass o Compass
Resi & Battry 0 Rosi & Battry (if the mic captures the audio from
Rt the phone speaker, a very high
pitch sound can happen!)
Voice will be streamed over BLE
P— You WI|| hear |t from the phone
Tap 1 ° Do not silence your phone,
More must NOT be vibration only!

Lys
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Voice over Bluetooth LE

s ~ J = 1
Generic Attribute Generic Access . . It S a VendOl' S peCIfIC
Profile (GATT) Profile (GAP) GAP configuration

\ Service!
Attribute Protocol I Security Manager Central (9 Peripheral
J (Master) (Slave)

GATT configuration

- B3
A
|

Logical Link Control and Adaptation Protocol

Audio: exported by the Server
through 2 dedicated BLE

characteristics

Link Layer I Direct Test Mode

Physical Layer

Host-Controller Interface i

Bluetooth Low Energy Stack Voice streaming over BLE:

Audio @8kHz

Codec: ADPCM
Bitrate: 32kbps

Lys
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BlueVoice ADPCM - Audlo 8kHZ ==

nw '

Central Peripheral

Advertise

Advertise Advert|sement Mode

Discovery Mode

Connect Request

No acknowledge required for Notifications: ] H
Connection created .
« OK for Audio streaming o o Peripheral-to- Audio can be

 Minimal Latency offeaton Central half-duplex
« Optimal Bandwidth communication

Notification

VO | ce Strea m | ng Connection Connection Connection Connection Connection
Event Event Event Event Event
<> <> <>

2 packets/event
20 bytes/packets
100 events/sec

* Audio Format: PCM 16 bit @ 8 kHz

« ADPCM Compression @ 32 Kbps:

Low latency and low complexity Radio

Idle
 Side Information at low data rate < ke = > -
T t |
enhances error resilience 10ms 160ms
Connection interval ADPCM Synch interval

32kbps

- Audio Data Packet, 20 bytes - Sync Data Packet, 6 bytes




BlueVoice Architecture

“Packetization” = User

|1 BlueNRG1 jt.c
ij gatt_db.c

ST dlgltal MEMS BlueNRG-2 | ] sensor.c

microphone .1 SensorDemo_main.c
ij HWAdvanceFeatures.c
. PDM PCM Raw Data =
. Audio » PDMto PCM ADPCM ol sorver - 1X 2 Stack

Acquisition conversion 8kHz ™ Compression GBB'UBtUgELl. 1 libbluenrgl_stack.a

gj stack_user_cfg.c

] libcrypto.a
3 OTA

\9 C3 VLs3Lx
Bitrate 32 kbps = &5 MotionFX

1 IotionFx100 CMOP Keil gtlib

=& BlueMRG1_BlueVoice_Library
U] blueveoiceADPCM_BMRGL_100_Keil.lib

“De-Packetization”

Smartphone app (ST BLE Sensor app)

Client - RX Raw Data Audio PCM Seriacl) Audio
93|Uet03%!f > Decompression g USB, Il;ts, — ))

life.augmented



Lab &
Over-The-Air (OTA) FW Upgrade
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Flash Memory Layout

0x1007E800
~ s
B
OTA &6
0x1005F800 BLE_Chat_Server_HigherApp_ OTA.bin
BLE_SensorDemo (((e; )))
LowerApp OTA
0x10040800
BLE OTA ResetManager
0x10040000

r REMEMBER TO LOAD THE BLE OTA Reset manager!!!

life.augmented



0x1007E800

0x1005F800

0x10040800

0x10040000

BLE Chat_Server_
HigherApp OTA

Empty

BLE OTA_ ResetManager

Once OTA is Completed...



Click on the top right
corner

—
=
¥

25.20°C

Not Present

NS

996.01 mBar 4710 %

ia & - oo

Mems SensorFusion  Plot Data Acc Event More

Lys
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OTA FW Upgrade (1/2)

Select “Firmware
Upgrade”

Start Logging

Show Debug Console

Firmware Upgrade

Settings

License Manager

Cancel

Select your remote

repository
I TIM = 16:29 ¥ % 23%@ )
Browse Cancel
Q, Search
Locations

& iCloud Drive

&. Google Drive

a Dropbox — Personal
—

m Recently Deleted

Favorites
Tags
® Red
@ Orange
Yellow
Green

Recents

Select the binary file

il TM T

€ Locations

Q  Search

i g

3/26/19
230 KB

3/26/19
214 KB

16:33 v % 23%@ )

Tile_DK1.1 Cancel

Sorted by Name ¥

@

BLE_Beacon_U BLE_Beacon_U BLE_Chat_Serv
se_OT..anager se_OT..anager er_Hig...pp_OTA

3/26/19 3/26/19
82 KB 76 KB

-

@

BLE_Chat_Serv BLE_Chat_Serv BLE_Chat_Serv
er_Hig...pp_OTA er_Low..p_OTA er_Low...p_OTA

3/26/19 3/26/19
214 KB 76 KB

@

—

Recents




OTA FW Upgrade (2/2)

OTA data transfer Click OK as
begins completed
| BLUENRG OTA ® BlueNRG1 Chat Rg-Connect tO.
Version: 1.0.0 0195AE3B-25C2-37E9-... BlueTile, now running

Mcu type: BLUENRG

PM1V100 \ a new application

CO0:6E:33:38:36:30

Flashing the new firmware

2048/75984 bytes

Upgrade completed

The board is resetting

l Ok l

Lys
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Customizing Your Design
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STEVAL-BCNO02V1B Block Diagram

Matching
Network’

BALF-NRG-02D3

Integrated balun

LSM6DSO 5C UART RXline
accelerometer + gyroscope ADC
LIS2MDL e BlueNRG-2
magnetometer Bluetooth 5.0 Network and
LPS22HH Application processor MP34DT05-A
barometer microphone

RGB LED

HTS221
Relative Humidity & Temp. connector
VL53LA1 12C
time-of-flight proximity

Lys
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Enable/Disable Sensors & Libraries
- Dedicated structure “FeaturePresence’ for
enabling/disabling sensors & libraries individually. File sensor.h

tyvpedef struct {
bool AccelerometerGyroscopePresence;
bool MagnetometerPresence;
bool HumidityTemperaturePresence;
bool PressurePresence;
bool ProximityLightPresence;
bool iNemoEngine;
bool Pedometer;
} FeaturePresence;

- SensorScan() function set each field of the structure to false or

ff Check sensor list

true. File sensor.c s

// Configure discovere d sensors
if (xFeaturePr .Pr ePr e)
Inic_Pre ure_’l‘ MpEerature_. S ens :}
. if theaturePresence.Humld y’I mperaturePresence)
Disable the unneeded tas fumsdicy Senzor ()
if (xFeaturePresence.MagnetometerPresence)
. . . Init Magnetometer():;
Sensor for OptImIZIng the if (®xFeaturePresence.bccelerometerGyroscopePresence)
Init Accelerometer Gyroscopel():
if (xFeaturePresence.ProximityLightPresence)

m power Consu m ptionl Init_Proximity_Sensor():

ff Configure sensors in low power mode
life.augmented SensorsLowPower () ;



BLE Timings

- Advertising intervals:

» Dedicated APl aci_gap set discoverable(Advertising Type,
Advertising _Interval Min, Advertising Interval Makx, ... )

* In file sensor.c

« Connection intervals:

 Dictated by the Central device. Peripheral has no full control on this.

* Notifications frequency

* Dedicated Virtual Timers (mapped on HW physical timers) for different
functionalities
 Timeouts defined in sensor.h

Fdefine BATTERY UPDATE RATE 1000 // Fized CDR @ 1 H=z

r fFdefine ENV SENSOR UPDATE RATE 100 // Fixed CDR @ 10 H=z
" fdefine MOTICN SENSOR UPDATE RATE 40 // Fized CDR @ 25 H=z

164




HW Modifications

* In this case redesign is of course necessary

« Schematics and Gerbers files:
® Onllne at WWWStCom/bluetlle 3.12.2 Functional description

The tabl